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Every Citrix product environment must have at least one shared or dedicated License Server. License servers are
computers that are partly or completely dedicated to storing and managing licenses. Citrix products request licenses
from a License Server if users attempt to connect.

Servers running Citrix products contact the License Server to obtain licenses.
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If users connect to a Citrix product, it draws licenses fromthe License Server. That is, the Citrix product requests to check
out a license fromthe License Server on behalf of the user or client device. When the license is successfully checked out,
the user can run the product.

Depending on the size and configuration of your product deployment, you might deploy licensing on a server shared with
other applications, a dedicated License Server, or multiple License Servers.

License files must be on the License Server that is associated with the product you are licensing. The product must be
configured to communicate with that specific License Server. The Citrix Licensing Manager and License Administration
Console let you manage and monitor your Citrix licenses by providing a user interface to the License Server. You can view
licenses and alerts, import license files, create historical usage reports, and manage License Server settings.
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What's new

Feb 28,2018
What's new in Windows builds

These new or enhanced feature in Build 23101.

Citrix Licensing Manager Enhancement. Simplify data export by allowing you to select all products, all license models,
and all Customer Success Services (Subscription Advantage) dates. Previously, you had to select a specific product, model,
and Customer Success Services date range.

uadmin.exe enhanced reporting output. uadmin.exe output provides better reporting and display of User/Device license
use. The .cvs file format reflects this enhancement. For more information, see Licensing commands.

These new or enhanced features in Build 22103.

e (Citrix Licensing Manager Enhancements. These enhancements allow you to:
e Enable and disable the supplemental grace period.
e Modify these ports:
e License Server (default 27000)
e Vendor Daemon (default 7279)
e Web Services for Licensing (default 8083)
e Set historical usage retention period.
e Display the License Server version, hostname, Ethernet address, and IPv address in the top bar of the screen.

These new or enhanced features in Build 21103.

e Citrix Licensing Manager Enhancements. Displays license details after licenses are installed using a license access code
or downloaded file.

These new or enhanced features in Build 20104.

e Citrix Licensing Manager Enhancements. These enhancements have been added to the Citrix Licensing Manager:
e Install licenses by using the license access code or a license file (lic).
e Retry failed usage statistic uploads to Citrix.
e Server configuration screen displays last upload information.

These new or enhanced features in Build 19005.

e Proxy settings. Windows automatic proxy detection is enabled for components requiring outward bound web
communications. The License Server automatically detects the proxy in its environment and communicates to the
intended recipient without manual intervention.
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e Citrix Licensing Manager Enhancements. Checks the availability of Subscription Advantage renewal licenses and can
notify you of their existence or automatically install the licenses.

Allows anytime configuration of Citrix Customer Experience (CEIP) and Call Home. Set this configuration during install or
upgrade. CallHome is a collection of basic usage and statistical information). For more information, see Citrix Licensing
Customer Experience Improvement Program (CEIP) and Call Home.

These new or enhanced features in Build 17005.

e (Citrix License Management Service. Allows for license management and support.
e Links to Citrix Insight Services to provide you with a license management console.
e Enables better Citrix support of your license environment.
e Provides essential information for you to understand and control your license environment while your organization
grows.

For more information, see Citrix License Management Service.

e Database storage - Database stores and exports the historical use data, increasing performance.

What's new in VPX builds

This new feature is available in License Server VPX Build 19800

e Active Directory, Citrix Licensing Manager, Studio, and Director integration support using License Server VPX.
The License Server VPX supports Active Directory integration for the Citrix Licensing Manager Studio, and Director
integration. Administer the users by using the Licensing Management Console. The configured Active Directory users can
log on to the Licensing Administration Console and the Citrix Licensing Manager.

This new or enhanced feature in Build 17000.

e New version of the Citrix License Server VPX. The self-contained Linux-based virtual appliance that allows
deployment of licensing in your Citrix environment.

These new or enhanced features in Build 16100.

o New version of Citrix License Server VPX. A self-contained Linux-based virtual appliance that allows deployment of
licensing in your Citrix environment. License Server VPX contains a script to export and import licenses and data and move
between VPX releases. You can bring the appliance online by:

e |mporting the appliance to your host or pool of hosts.
e Configuring basic networking - specifying IP address, hostname, and other network information.
e Using the License Administration Console to upload licenses for your hosts.

e Call Home. Call Home capabilities have been extended to detect Citrix Service Provider licenses and report product usage

to Citrix. For more information, see Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home.
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Known and fixed issues

Feb 26,2018
This article contains:

Installation issues

Other known issues

Other known issues and considerations - License Server VPX Only
License file issues

Fixed issues

Known issues

Installation issues

e |f Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled (the default configuration for
Windows 2008), connections can fail. Connecting remotely to the console or checking out licenses works until failover
occurs in the cluster. Exception rules for CITRIX.exe and Imadmin.exe are created during installation of Licensing and
Simple License Service, but do not work after a cluster failover. To work around this issue, create exceptions for Licensing
components on the Exceptions tab of the Windows Firewall panel. Create an exception for each of the following ports:
Console Web Server port (default port is 8082); License Server Manager port (default port is 27000); Simple License
Service port (default port is 8083); and Vendor Daemon port (default port is 7279). This issue occurs with Windows Server
2008 (32-bit and 64-bit), Windows Server 2008 R2, and Windows Server 2012. For more information,
seehttp://support.microsoft.com/kb/2568645. [#232365]

e During the installation, the Configuration page is presented. If you choose not to configure the License Server, you can
configure it at a later time. You must restart the License Server installer or use the configuration tool. You can open the
tool from: C:\Program Files\Citrix\Licensing\LS\resource\Licensing.Configuration.Tool.exe. If the License Server
Configuration tool fails for any reason, uninstall and reinstall the License Server.

e During installation, localized characters in the installation path can cause the installation to fail. Accept the default
installation path or enter only ASCII alphabetic letter characters for the installation directory. [#229456]

e When configuring the product-side setting for the License Server name, do not use localhost. Though you can use the
host name, IP address, or FQDN instead, Citrix recommends you use the FQDN. [#165986]

Other known issues

e The username is case sensitive in some localized languages. To log on to Citrix Licensing Manager, set thedomain-
name\username in UPPER CASE if it contains non-ASCIl characters. [#595621]

e |f you upgrade an older, existing clusterto 11.12.1, the message, "The installation drive is not part of the selected cluster
group. Select the correct cluster group or add the drive to the selected group." displays. To successfully use the new
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1112.1 clustering features, you must uninstall any License Server older than 11.12.1. The older License Servers do not
conformto current Microsoft cluster guidelines.

When you try to start the License Administration Console or the Citrix Licensing Manager, a blank page might display if
the Internet Explorer Enhanced Security Configuration is enabled and the License Administration Console or the Citrix
Licensing Manager is not in the Trusted Sites. Workaround: Disable Internet Explorer Enhanced Security Configuration.
[#382429]

When you access Citrix Licensing Manager fromthe Start menu for the first time afterinstallation, an error message
might appear on Firefox and Chrome browsers. [#LIC-195]

Older Desktop Studio releases (prior to XenDesktop 7 Studio) using this version of the License Server do not display
license usage information or manage the License Server using the Licensing Node. This version of the License Server is
fully compatible with XenDesktop and can serve licenses for any Citrix product deployment. If you continue to use an
older Desktop Studio, use the License Administration Console that ships with the License Server to display license usage,
manage License Server users, and upload licenses. If you are using a version of XenDesktop prior to the XenDesktop 7
and you upgrade from earlier versions of Citrix License Server for Windows to version 11.11.1 and 11.12.1, you might see
the following warning:

Warning: Installing this update removes the Licensing Configuration Service. As a result, all versions prior to this release of
Studio provide only limited licensing information.

On non-English platforms, when starting a License Service installation on a cluster node, the Cluster Group list on the
Configure screen might contain the system default Cluster Group. Select one of the non-default Cluster Groups and the
installation continues normally. [#497524]

Other known issues and considerations - License Server VPX Only

After a CEIP upload failure, the log file location doesn't appear in the error message displayed on the Citrix Licensing
Manager. The log file location is /opt/citrix/licensing/LS/logs/log_ctxuploader.txt. [#LIC-396]

Sometimes after a few failed attempts to join Active Directory, when the Active Directory integration succeeds, you
might see an LDAP error during the initial configuration of the License Server VPX.

Workaround: Run resetsettings.sh and reenter the details.

A network error might appear the first time you access the Citrix Licensing Manager from the Chrome browser.

Workaround: Refresh the page.

If you access the Citrix Licensing Manager from outside the domain to which it has been joined, you might be prompted
for credentials multiple times. You might need to change your browser settings. For more information, see
https://techsupport.osisoft.com/Troubleshooting/KB/KB01223.

The user name of the logged on user displayed on the Citrix Licensing Manager page is in the domain\user format. The
Citrix Licensing Manager of a License Server for Windows displays the user name as user@domain.

When configuring XenDesktop 7.0 through 7.13 or XenApp 7.5 through 7.13, use the PowerShell Set-Configsite cmdlet
to point to License Server VPX. If doing a fresh install, install and configure XenDesktop and XenApp using its installer,
and then use PowerShell to reconfigure and point to License Server VPX.
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Set-ConfigSite -LicenseServerName <DNS_name/IP_of_licence_server> -LicenseServerPort <port>

e Ports 1through 1024 are reserved by the operating system. When configuring the VPX ports, use ports higher than 1024.
By default, VPX uses port 8082 for SSL, which is open in the firewall. If you choose a different port for SSL, reconfigure
the firewall in the iptables.

e Upgrades are not supported for License Server VPX.

License file issues

e Certain license types are not covered by Citrix Subscription Advantage. Therefore, they appear in alerts in the Dashboard
of the License Administration Console indicating that the Citrix Subscription Advantage date is expired. You can ignore
such alerts for any license not covered by Citrix Subscription Advantage. This includes Evaluation licenses, Not for Resale
licenses, Early Release licenses and Technology Preview licenses. These types of licenses do not need Citrix Subscription
Advantage and your Citrix products do not stop working when the Citrix Subscription Advantage date is expired. You can
verify the status of any license for which you receive an alert by clicking the license on the Dashboard. The license
information expands to show the license type (such as Technology Preview), the license expiration date, and the Citrix
Subscription Advantage date. [#231847]

e The License Server ignores license files with multiple lines referencing HOSTNAME=. Licenses in these files cannot be
checked out. This issue is caused when you download licenses associated to different License Server hostnames into the
same license file. The License Administration Console displays the following error message: “..Error List
Returned..Unknown Host."

To resolve this issue, download again separate license files for each Citrix product tied to different License Server names.

e Afteryou replace evaluation license files on the License Server with new license files, the Citrix product might continue
to display the following license expiration message when users log on: "Warning: The following Citrix Product is using an
Evaluation license. This license will expire in..."

To resolve this issue:

1. Remove the old evaluation license files from the License Server. (See Delete license files in Citrix documentation.)

2. At the License Server, restart the Citrix Licensing service.

3. At the Citrix product server that needs license validation, point to a fictional License Server and then point the
product back to the actual License Server. (See your product documentation for information about changing these
settings.)

4. If the problem persists, restart the product server (for example, Delivery Controller).

Fixed issues

Fixed in VPX Build 23101:

e Incorrect installed license information is displayed in the historical usage report. [#LIC-405]

e Opensslupgraded from1.0.21to 1.0.2n to include security fixes. [#LIC-404]
Fixed in VPX Build 19800:

e (itrix License Server VPX, Build 17000. Using https:// FQDN:8082 to access the License Administration Console, might
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cause the CITRIX daemon to exit. To recover, restart the License Server. [#LIC-313]

e |n License Server Configuration on the License Administration Console, don't choose Default Port for the License Server
Manager and restart Citrix Licensing Service. Choosing this option results in an inaccessible License Server. [#LIC-180]

e Studio does not display license usage information or manage the License Server. Use the License Administration Console
that ships with the License Server to display license usage, manage License Server users, and upload licenses.

e The License Server VPX does not support Active Directory.
Fixed in Build 22103:

e The Citrix Licensing Administration Console version 21103 incorrectly displays the version number as v11.14.1.1. The correct
numberis 11.14.0.1.

e When using the Citrix Licensing Manager to install another license, a distorted display of the installed licenses
information might appear on the right side of the screen. [#LIC-282]

e |nthe Citrix Licensing Manager Server Configuration page, changing the language to French or German might cause an
error. If this error occurs, the Historical Usage drop-down menus are empty. [#LIC-317]

Fixed in Build 20104:

e Whenyou try to start the Citrix Licensing Manager and Firefox is the default browser, the Citrix Licensing Manager is
inaccessible and Firefox displays a generic error message. [#L1C-107]

e Failed Citrix Licensing Manager upload notifications are not deleted after you disable CEIP and Call Home. [#LIC-188]
Fixed in Build 18001:

e This fix deletes occasional rogue characters fromthe Citrix License Management Console. [#LC5354]

Fixed in Build 17005:

e |mhostid returns blank when it is queried to return an IPv6 type of address. [#621679]

Fixed in Build 17000:

e The udadmin command might not delete licenses when there is an apostrophe in the device name. [#LIC-142]

e Assigning a busy port to the vendor daemon or License Administration Console might result in the vendor daemon going
down or the Licensing Administration Console becoming inaccessible. [#LIC-65]
e Windows - The vendor daemon goes down if you update the vendor daemon port by using a port that is already busy
followed by a service restart. Access the License Administration Console and update the vendor daemon port by using
a valid free port followed by a restart to restore License Server.
e VPX - This situation requires a support call.
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Third party notices

Feb 26,2018
Citrix Licensing 11.14 might include third party software licensed under the terms defined in the following documents:

-----------

poF : Non-Commercial Software Disclosures For FlexNet Publisher 2016 R1 (11.14.0.0)

...........

-----------

. por 1 FlexNet Publisher Documentation Supplement Third Party and Open Source
Software used in FlexNet Publisher 11.14.0
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System requirements for Citrix Licensing

Feb 26,2018
Requirements for Licensing for Windows

Citrix Licensing is compatible with the same hardware required to support the compatible operating systems. No additional
hardware is required.

Note

® The license server does notsupport multi-homing (two network cards plugged into distinct networks).

® The License Administration Console manages the License Server on the computer on which itis installed. It cannot manage
remote or third party License Servers. The Citrix Licensing Manager caninstall licenses only on the License Server where itis
installed. We recommend installing the License Server on server operating systems only. The consoles can be accessed from
any server or clientoperating system using a web browser. License Servers cannot communicate with each other.
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You can install the license server on servers running the following Microsoft operating systems. Citrix
recommends thatyou install the latest Microsoft Service Pack and updates.

Windows Server 2016 Family

Windows Server 2012 R2 Family

Windows Server 2012 Family

Windows Server 2008 R2 Family

Windows 10, 32-bitand 64-bit editions (notsupported with Build 18001 or later)

Windows 8.1, 32-bitand 64-bit editions (notsupported with Build 18001 or later)

Windows 8, 32-bitand 64-bit editions (notsupported with Build 18001 or later)

Windows 7, 32-bitand 64-bit editions (notsupported with Build 18001 or later)

Operating system

e 161 MBfor the licensing components

Disk space ® 2 GBforuser/device licensing
requirements

Microsoft.NET
Framework Microsoft.NET Framework 3.5SP1 or greater is required.
requirements

e Windows Server 2016 Family
e Windows Server 2012 R2 Family
e Windows Server 2008 R2 Family

Cluster platforms

We tested the following browsers. Other browsers might work, but all functionality might not be available.
® InternetExplorer Version 11
e MicrosoftEdge
Browsers e Mozilla Firefox
e Chrome
Safari

Requirements for installing License Server VPX

XenServer must provide adequate virtual computing resources to the License Server VPX as listed in this table.

© 1999-2017 Citrix Systems, Inc. All rights reserved. p.10



512 MB. Sufficient for up to 500 Citrix servers and approximately 50,000 licenses. Monitor available memory
Memory during operation to determine if you require more memory. For larger environments, we recommend
allocating more memory.

XenServer version XenServer7.0, 7.1,72,and 7.3.

Minimum Storage ) .
) 8 GB on the default Storage Repository inside the XenServer pool.
Requirement
Virtual CPU (vCPU) 1 vCPU. For larger environments or those using user/device licensing, consider adding a second vCPU.

We tested the following browsers. Other browsers might work, but all functionality might not be available.
® InternetExplorer Version 11

® MicrosoftEdge
Browsers o Mozilla Firefox

e Chrome

e Safari
Active Directory For Active Directory integration of the VPX, a keytab file is mandatory and can be created only on a Windows
Integration and Citrix Server OS. Citrix Licensing Manager is notavailable until Active Directory is configured and the keytab file is
Licensing Manager properly installed.
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Technical overview

Jun18,2018
Before you can use your Citrix product, you must install Citrix Licensing. Citrix Licensing is a system of components that
function together. This system includes:

License server. A systemthat allows licenses to be shared across the network.

License files. The files needed to license your product. These files are stored on the License Server.
Citrix Licensing Manager. Enables the following:

In latest build:

o Simplify data export by allowing you to select all products, all license models, and all Customer Success Services
(Subscription Advantage) dates. Previously, you had to select a specific product, model, and Customer Success Services
date range.

In previous builds:

e Enable and disable the supplemental grace period.

e Modify these ports:

e License Server (default 27000)

e Vendor Daemon (default 7279)

e Web Services for Licensing (default 8083)

Set historical usage retention period.

Display details of licenses after they are installed using a license access code or downloaded file. - Build 21103
Allocation and installation of license files on a License Server using a GUI.
Installation of licenses by using the license access code or a license file (.lic).
Configuration of Customer Experience Improvement Program (CEIP) and Call Home.
Retry failed usage statistic uploads to Citrix.

Automatically or manually checks for Customer Success Services renewal licenses and notifies you or installs the licenses

if found.

e Enables the creation and exporting of License Server historical usage reports and configuration of historical data
retention. Default data retention is 180 days.

e Notifies you of the License Server state - Missing startup license, time issues, uploader failures.

License Administration Console. The interface you use to manage your license files and your License Server.
Web Services for Licensing. Enables Studio, Director, and the Licensing Administration PowerShell Snap-in to:

e Communicate with the License Server and manage users.
e Allocate and install licenses.
e Display License Server health, license usage, and other alert messages.

Citrix License Management Service. Enables management of your license environment through a license management
console within Citrix Insight Services. This service assists with license management and support:

e Allocating new licenses if you are about to exceed your license capacity
e Rescinding old licenses after an upgrade
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e Managing duplicate licenses in a Disaster Recovery (DR) environment
Product-side settings in your Citrix products that are associated with the License Server.

For more information, see Licensing elements and Services.

Licensing operations overview

Typically, the first time a user connects to a Citrix product, the product requests a license fromthe License Server. When the
License Server grants a license request, the Citrix product reserves a license for its use. Reserving licenses for this purpose is
known as checking out licenses. When the user logs of f from the product server, the product returns the license to the
License Server. This process is known as checking in licenses. Some Citrix products check out the license when a user
connects to the product, and the license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the License Server by checking out the startup license. The
startup license is a Citrix system file that enables Citrix products to maintain a continuous connection to the License Server.
The following figure shows that each product forms its own constant connection to the License Server.

For example, when a server running XenDesktop requests a license, the product retrieves the License Server name and port
number information fromthe data store. The product then establishes a connection to acquire the appropriate licenses.

Note

When configuring the product-side setting for the License Server name, do notuse localhost Though you can use the hostname, IP
address, or FQDN instead, Citrix recommends thatyou use the FQDN.

There are three stages of the license checkout process.

1

(— ;
] /'- Startup license
1 -
D License Server
D
==}
Citrix product
server 3
3
XenDesktop
2 licenses
Iﬁ NetScaler
-— Gateway
User devices licenses

A Citrix product goes through a three-step process to check out licenses:

1. At startup, a computer running a Citrix product checks out a startup license.
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2. Aclient device connects to the product server.
3. The product requests a license fromthe License Server.

Citrix products, such as XenDesktop, store a replica of the licensing information from the License Server, including the
number and type of licenses. If a Citrix product server loses its connection to the License Server, or the License Server does
not respond in a timely manner, the product enters a grace period. During the grace period, the product uses its local record
of the licenses to continue licensing the product. Citrix products update this record every hour.

Scalability

This section provides guidance to ensure successful License Server usage by examining the impact of license usage
scalability in a Citrix environment. We performed the following scalability testing:

Virtual Machine Hardware/Configuration:
Intel Xeon E5-2650 v3 @ 2.30 GHz

4 Virtual CPUs

8 GB RAM

Windows Server 2016

6.5 and earlier Concurrent:

e 3000 connected XenApp servers
e 53,000 concurrent licenses
e 50-60 connections per second

Efforts to scale more than 53,000 licenses result in servers going into a grace period. Also, there are issues with WMI, Imstat,
and the License Administration Console. We recommend that you maintain 50,000 or fewer concurrent connections per
License Server.

7 x Concurrent:

e 16 Delivery Controllers
e 70,000 concurrent licenses
e 50-60 checkouts per second

7 x User/Device:

e 16 Delivery Controllers
e 150,000 User/Device licenses
e 50/60 checkouts persecond

CITRIX.exe is a single threaded process. While serving Concurrent connections, the maximum connection limit is based on
single core processor speed. During peak activity, CITRIX.exe uses 100% of a single core and eventually starts timing out.
This usage might cause Citrix products to go into a grace period or errors in the License Administration Console or other
License Server utilities. After the License Server has processed backlog connections, it returns to normal. Monitor
CITRIX.exe processor usage to determine if a faster processor is required. We recommend if you experience issues in high
scalability environments, you deploy more License Servers.

User/Device technology is multi-threaded and scales better than Concurrent. During license optimizations, you might see
that periods were licensing activity takes 100% of a single core. This usage is normal and doesn't impact CITRIX.exe
processor usage or functionality. We recommend that you monitor License Server resource usage and add more License
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Servers to maintain a properly functioning environment.

Note

Running WMI, Imstat, Imutil, or other inventory actions can negatively impactLicense Server performance. We recommend thatyou
minimize these activities. If you require usage data, exportthe data from the Citrix Licensing Manager. For more information, see
Historical usage.

Grace periods

If product servers lose communication with the License Server, the users and the products are protected by a grace period.
The grace period allows the product servers to continue operations as if they were still in communication with the License
Server. After the Citrix product checks out a startup license, the product and the License Server exchange "heartbeat"
messages every five minutes. The heartbeat indicates to each that they are still up and running. If the product and the
License Server don't send or receive heartbeats, the product lapses into the licensing grace period and licenses itself
through cached information.

Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. The Windows Event Log, and
other in-product messages, indicate if the product has entered the grace period, the number of hours remaining in the
grace period. If the grace period runs out, the product stops accepting connections. After communication is re-established
between the product and the License Server, the grace period is reset.

The grace period takes place only if the product has successfully communicated with the License Server at least once.

Grace period example - two sites, both using the same License Server

The connection between Site 1 and the License Server goes down causing Site 1 to go into the grace period, continuing
operation and making connections. For concurrent licenses, they can connect up to the maximum concurrent licenses
installed. For user/device licenses, they have unlimited connections. When Site 1 reestablishes communication with the
License Server, connections are reconciled and no new connections are allowed until they are within normal license limits.
Site2 is unaffected and operates as normal.

If the License Server goes down, both sites go into the grace period. Each site allows up to the maximum number of
licenses installed. As above, the user/device licenses have no limit.

Supplemental grace period
For the supplemental grace period to be available, you must use a minimum of XenApp 7.6 or XenDesktop 7.6.

If all licenses are in use, supplemental grace period enables unlimited connections to a product, allowing you to understand
and address the issue. This period lasts until 15 days elapses or you install more retail licenses, whichever comes first. We
recommend that after the supplemental grace period starts, you allow it to run out rather than adding licenses immediately
to clear the warning condition.

After the period expires, normal connection limits are enforced. Users are not disconnected, but as they disconnect, no new
connections can occur until license levels return to normal.

Once the supplemental grace period completes, it isn't automatically reenabled. To reenable the supplemental grace period,
install another retail license, and then normal license limits are enforced. When you reeneable the supplemental grace period
by installing the new retail license, a new 15-day supplemental grace period starts the next time you exceed maximum
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installed licenses.

Note

If you install licenses while the supplemental grace period is in force, the License Server exits the supplemental grace period.
Reenabling the supplemental grace period before determining the reason for the supplemental grace period might cause you to
reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail licenses.
The supplemental grace period is enabled by default when you first install licenses. To disable it, add the following line to
the CITRIX.opt file and restart the Citrix licensing services:

#CITRIX SGPOFF

Supplemental Grace Period example:
If you have a maximum count of 1000 licenses installed, and you make another connection (maximum licenses + 1), the

supplemental grace period starts. You then have a temporary, 15-day period giving you extra capacity to deal with
unforeseen capacity issues.

Important

® The supplemental grace period and license overdraftare two differentfeatures. The supplemental grace period is a feature of
the productand the License Server. License overdraftis a feature of the license. For information aboutlicense overdraft, see
License overdraft

® |icense Server VPX does notsupportsupplemental grace periods.

Related information

Licensing elements

License files

Citrix Licensing Manager
License Administration Console
Services
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Licensing elements

Feb 26,2018
The License Server comprises several licensing elements:

Citrix vendor daemon

Options configuration file

Citrix Licensing Customer Experience Improvement Program (CEIP) and CallHome
License request process

This diagram shows the Citrix product using TCP/IP to connect to License Server.

License Server

TCRAP Citrise A—  Cptionsfile

port Wendor
Citrix product S — Daeman

License files

I
= A

License Wieh Services
Administration for Licensing
Console

T

Citrix
Licensing Citrix -
WM Licensing Citrix
Support Licensing
Service ® Manager

* Hosts the Citrix License hanagerment Service and
Customer Experience Improvement Program and Call Home,

Citrix vendor daemon

The Citrix vendor daemon (CITRIX), a process that runs on the License Server, grants licenses. The Citrix vendor daemon
tracks the number of licenses that are checked out and which product has them. Citrix products communicate with the
Citrix vendor daemon using TCP/IP. By default, the Citrix vendor daemon uses TCP/IP port 7279.

Options file

The options file (Citrix.opt) is a License Server configuration file that the Citrix vendor daemon reads every time it restarts or
receives a command to reread the file. This configuration file defines licensing behavior-the number of licenses a product
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server can use, the location of the System Logs, logging levels, and other user-defined customizations. The Customer
Experience Improvement Program (CEIP) and Call Home configurations are stored in this file.

Important

Though Flexera offers ways to editthe options file to control, reserve or limitlicensing usage, they are not compatible with Citrix
licenses. Therefore, we do notsupportthose editing options.

Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home

The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to
improve your product experience. After installing the License Server, you can participate in the programs anonymously or
choose to be identified. Internet access is required. For information about configuring a proxy server, see "Configure a
proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program (CEIP ) and CallHome" in the
Get started article.

CEIP is enabled by default during License Server installation. You can change your participation in the program at any time
by using the Citrix Licensing Manager.

Important

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can
change the settings, butyou cannotdisable CEIP or Call Home. When the License Server detects Citrix Service Provider licenses, it
enforces daily uploads.

When installing licensing on the command line, use CEIPOPTIN to specify whether, or how, to opt into CEIP or CallHome
Optional parameter. The default is CEIP.

Diagnostic - CallHome

Anonymous - CEIP

None

For more command-line installation information, see the "Use the command line to install licensing" section under Install
licensing components for Windows.

You can change the choice made at installation by editing the CITRIX.opt file:
#CITRIX CEIP value
Where value is DIAG, ANON, or NONE

On VPX, do not change the CITRIX.opt file. As root, execute the following command and make your choice of CEIP [1.DIAG
2.ANON 3.NONE]

# reset_ceip.sh

Citrix Licensing Customer Experience Improvement Program (CEIP)
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CEIP is voluntary. When you opt in, the CEIP services running in Citrix products gather anonymous configuration and usage
data fromyour deployment. The services automatically send the data to Citrix once a week, based on the service start
time. CEIP collects these classes of data:

e Configuration data
e Performance and reliability data

How your privacy is protected:

e (itrix does not collect any personally identifiable data.

e Randomidentifieris created at install time, which tracks data transfers over time.

e (itrix does not record information such as IP addresses, server names, or domain names.
e Alldata is sent using HTTPS directly to Citrix servers - no third-party data hosting services.
e Alldata is secured on Citrix servers and is accessible only by authorized individuals.

Citrix Call Home

CallHome is voluntary. When you opt in, Call Home performs periodic collection of systemand product configuration,
performance, errors, and more. The data identifies you as a customer. This information is transmitted to Citrix Insight
Services once a week, based on the service start time. Citrix support and product teams use the information to resolve
issues proactively.

The License request process

When a product requests a license fromthe License Server, the Citrix vendor daemon determines whether a license is
available for the request.

The license request process has two phases: the product startup phase and the user connection phase.

Product Start-Up Phase

e When a Citrix product starts, it retrieves the License Server location fromits data store
e The product connects to the Citrix vendor daemon
e The product checks out a startup license

User connection phase

e A userconnects to a computer running the Citrix product

e The product requests a license fromthe License Server

e The Citrix vendor daemon checks to see if any licenses are available and grants or denies the product's request

e The license module in the product grants or denies the use of the product based on the response fromthe Citrix vendor
daemon
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License types
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Your product uses one of the following types of licenses (some products allow you to select more than one type). Ensure

that you are aware of the types of licenses your company purchased and how they are consumed so you don't run out of
licenses. We also offer license overdraft as a feature of the license files. See the license overdraft description at the end of
this article.

The license types are:

User/device licenses

With a minimum of XenDesktop 5 Service Pack 1 and XenApp 6.5 or later: The license server can assign licenses to a user or
a device and monitor license consumption. When assigned to a user, the license allows access from an unlimited number of
devices. When assigned to a device, the license allows access from the device by an unlimited number of users.

A licensed device requires a unique device 1D and is authorized for use by any individuals to access instances of XenDesktop.
Use this type of license for shared devices, such as a classroom or hospital.

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the
user to connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook,
smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently.

When users or devices connect to an application or desktop, they consume a license for the 90-day license assignment
period. The assignment period begins when a connection is made. The period is renewed to the full 90 days during the life
of the connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If
you have to end a license assignment manually before the 90-day period elapses, use the udadmin command-line tool. For
example, an employee consuming a user license leaves the company.

Optimization

Using the optimization process, the License Server determines how to minimize consumption based on licenses in use and
connections to the License Server. The license server optimizes every five seconds until there are 5000 unique connections.
At 5000 unique connections, optimization occurs every five minutes. Optimization might delay status information until the
next optimization impacting when license usage statistics are updated in various consoles.

Examples of unique connections - Optimization is not consumption and these examples show when optimization occurs.
Optimization occurs every five seconds for 1-4999 uses and every five minutes for 5000 or more uses.

700 users * 1 device each = 700 (optimize every 5 seconds)

5000 users * 1 device each = 5000 (optimize every five minutes)

5000 devices * 1 user each = 5000 (optimize every five minutes)

2500 users * 2 devices each = 5000 (optimize every five minutes)

Note
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If you have a large deployment, optimization can be CPU intensive depending on the number of unique connections. We
recommend using machines with multiple cores.

Concurrent licenses

This type of license is not tied to a specific user. When a user starts a product, the product requests the license and it's
checked out to the specific computer or device that the useris using. When the user logs off or disconnects fromthe
session, the license is checked back in and is available for another user. Using this logic, keep the following scenarios in mind:

e Multiple sessions at different computers use multiple licenses. Each time a user starts a Citrix session from a different
computer or device, a license is checked out until the user closes the session at that computer or device. At that point,
the license is checked back in. For example, a user starts a session from one computer and then starts another from
another computer (before closing the first session), two licenses are checked out.

e License servers do not communicate with each other. If you run multiple license servers, you might consume more than
one license (for example, with load balancing). If you are using load balancing, Citrix recommends that the product servers
point to the same license server.

e Different editions consume different licenses. If a user connects to an application published on a computer running
Advanced edition, and then uses the same client to connect to an application published on a computer running
Enterprise edition, two licenses are consumed.

e Only one license is consumed. A user makes multiple connections from a single device to different product servers
configured as the same edition and pointing to the same license server.

e A user connects from a single device to two product servers that are the same edition but different versions. One or two
licenses might be consumed based on the order in which the user makes the connections. For example, the two servers
are XenApp 6.0 and XenApp 6.5 (though this example applies to nearly all Citrix products and versions):

e The user connects to XenApp 6.0 first - Two licenses might be consumed - An older license first and then a newer
license.
e The user connects to XenApp 6.5 first - Only one license is consumed.
e RDP connections consume a license (RDP connections to a console do not consume a license).

Per user licenses (Only user licenses - not the same as user/device licenses)

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the
userto connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook,
smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently. A licensed user
can connect to multiple instances of a product concurrently. When users connect to an application or desktop, they
consume a license for the 90-day license assignment period. The assignment period begins when a connection is made. The
period is renewed to the full 90 days during the life of the connection. Expiration (allowing reassignment) is 90 days after
the last connection ends (logs off or disconnects). If you have to end a license assignment manually before the 90-day
period elapses, use the udadmin command-line tool. For example, an employee consuming a user license leaves the
company.

Per device licenses (Only device licenses - not the same as user/device licenses)

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of a product.
Use this type of license for shared devices, such as classroom or hospital. It allows an unlimited number of users per device.
When devices connect to an application or desktop, they consume a license for the 90-day license assignment period. The
assignment period begins when a connection is made. The period is renewed to the full 90 days during the life of the
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connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If you
have to end a license assignment manually before the 90-day period elapses, use the udadmin command-line tool. For
example, an employee consuming a user license leaves the company.

Per socket licenses

Licenses are consumed per CPU socket used by a CPU and cores are not counted. For example, if a computer having two
CPU sockets has only one CPU, only one license is used. In another example, if that same computer with two sockets has
two CPUs, each with a quad core, only two licenses are used.

Named user licenses

When a product requests a license, it is checked out to the user until a preconfigured period expires. This type of check-out
is not tied to a computer or device. After the license is checked out, the user can run multiple sessions on different
computers without checking out more licenses.

License overdraft

License overdraft is included in all user/device, per user, and per device licenses. When you purchase user/device licenses, you
receive a 10% overdraft. The overdraft becomes available after you allocate all your purchased and evaluation licenses.
Overdraft usage is reported in Studio and the License Administration Console. If you routinely use overdraft licenses, we
recommend that you purchase more licenses to maintain compliance.

Example:
You purchase 1000 user/device licenses and get 10% overdraft. You actually have 1100 user/device licenses to use.

If you go over 1100, a 15-day supplemental grace period starts. For more information on supplemental grace period, see
Supplemental grace period.
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License files
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When you install the license server, a startup license and an options file are installed automatically. To license your Citrix
products, you add one or more license files. For information about adding your product licenses, see Obtain your license
files.

You cannot change the location of license files on the License Server. License files must reside in their default location.

Startup license file

The startup license file (citrix_startup.lic) is a text file that Citrix products use to communicate to the License Server using a
continuous open connection. Every five minutes the license server and the product send a heartbeat message to each
otherto verify that they are mutually communicating. When the product and License Server are exchanging heartbeat
messages, but there is an interruption in the exchange, the product goes into a grace period. A power failure is an example
of aninterruption. The startup license does not affect your license count.

Citrix License Server Diagnostics License |Server

The License Server uses Citrix License Server Diagnostics License | Server for internal diagnostics and alert message
notifications displayed in Studio and Director. It is available by default with the startup license in the citrix_startup.lic file.

Caution: Do not edit the startup license file, or any other license files.
License file
The license file is a text file containing the following:

Product licensing information

License server name (or other binding identifier)

Customer Success Services membership renewal date (also known as the Customer Success Services expiration date)
License expiration date (if applicable)

Other system information

All this information is encrypted using a digital signature. When you purchase a Citrix product, go to the citrix.comwebsite
to download a license file. You can have more than one license file per license server. The license file resides in the

e C:\Program Files\Citrix\Licensing\MyFiles directory on a 32-bit server
e C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server
e /opt/citrix/licensing/myfiles directory for License Server VPX

Where the license server references it. The License Server uses this file to determine whether or not to grant a license to a
Citrix product.

A license overdraft is included in all user/device, per user, and per device licenses. For more information on the license
overdraft, see License overdraft.

Move license files to a different host

You cannot move the license files that you downloaded for the old license server to a server that has a different hostname
or MAC address. Create license files that reference the new server name by reallocating them.
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See Reallocate license files for more information.

License file format

Important

Changes can make license files unusable. If using Citrix Licensing for Windows 11.6.1 or later, editing license files is notnecessary.
You can manage licenses through the Citrix Licensing Manager, the License Administration Console, and the My Accountsite.

Note: You can change the name of the license file, but it must have a .lic (lower case) extension.
Citrix license files use the following naming convention: license_FID_XDT-PLT-UD_25-mar-2013.lic.

License files are composed of lines listing specific information, such as the server name (SERVER) or quantity of licenses
(INCREMENT). These lines begin by using words denoting their purpose in uppercase letters, such as VENDOR, SERVER,
INCREMENT, USE_SERVER.

The following sections provide in-depth information about the following elements of license file syntax: the SERVER line,
VENDOR line, USE_SERVER line, and INCREMENT line. While the term feature is used in the options and license file syntax,
in this document, the term product license is used whenever possible for clarity.

Example license file displaying numbers corresponding to the explanations following the example:

# This file is in UTF-8 format.

#

SERVER this_host HOSTHAME=Slicense serverl

YENDOR CITRIX

LUSE_SERVER

INCREMENT MPS_ENT_CCU CITRIX 20065.0428 01-may-2006 1000 %
WENDOR_STRIMNG=;LT=Retail, GP=7 20, CL=ENT ADY STD;5A=0,0DP=0
DUP_GROURP=Y ISSUED=12-har-2004 NOTICE="ehail Test - Citrix" %
SN=LA-0000150712-86261:6872 START=11-mar-2004 SIGN="0885 F320"
0OAEZ EE72 B3A4 02FC BEC2 3648 AZCF 346D ARSF ED44 TS111Y
D790 1830 7535 553C B774 DEBC 1F5D AAD3 DAFE DOVE 2178 BHOAO &

A14C 2893 7756 ACFS"
e (4
#HEnglish)
HCITRE-TERM FEATURE 2.0 MPS STD CCU EN Citrix Presentation Server Standard|Concurrent User
HCITRE-TERM FEATURE 2.0 MPE_ADY CCU EN Citrix Presentation Server Advanced|Concurrent User
HCITRI=TERM FEATURE 2.0 MPS EMT CCLU ENM Citrix Presentation Serer Enterprise|Concurrent User
#
1 SERVER Line

The SERVER Line. The SERVER line specifies the binding identifier (also known as the hostname) of the license server.
Caution: Do not change the binding identifier on the SERVER line. Otherwise, the license file doesn't work.
Syntax

SERVER this_host ether
Or
SERVER this_host HOSTNAME=hostname

Parameters | Description
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Bther Bhe l\/lAg address of the appliance on which the license server is running. Do not edit this text string.
arameters escription

hostname The name of the computer on which the license server is running. Do not edit this text string.

Example
SERVER this_host HOSTNAME=license_serverl

2 VENDOR Line
The VENDOR line specifies the Citrix vendor daemon name.

Syntax
VENDOR CITRIX [vendor_daemon_path]

Field Description
VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit this name.

vendor_daemon_path | Pathto the executable forthe Citrix vendor daemon. Citrix recommends that you do not
change this path.

3 INCREMENT Lines

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or more INCREMENT
lines. Each INCREMENT line makes up a user-specified allocation of product and license (users, connections) counts.

Each increment line contains:

e Asignature based on the data in that line
e The hostids specified in one or more SERVER lines
e Data selected by Citrix

INCREMENT lines use a backslash (\ ) to wrap long lines of text.

Syntax

INCREMENT feature vendor css_expiry_date exp_date num_lic\

SIGN=sign [optional_attributes]
Caution: Do not change the six fields after the INCREMENT line keyword. The fields are required and have a fixed order.
The following table explains these fields in the order they appear:

Field Description

feature The product license. Do not edit this line.

vendor Indicates that this license is for a Citrix vendor daemon. Do not edit this line.

Indicates the date until which you are entitled to product version upgrades. If you don't have
a Customer Success Services membership, or this license isn't a Customer Success

Services license, the date indicates when you ordered or redeemed the license. Do not edit
this line.
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Note: If you renewed your Customer Success Services membership and received an upgrade
license, two dates are listed.

e The first date is the date when the Customer Success Services membership was originally
CSS_expiry_date purchased
e The second date is the CC_expiry_date

Example:
INCREMENT MPS_ENT_CCU CITRIX 2005.0311 2007.0311 permanent 1000 \

See Upgrade Lines for additional information.

Expiration date of license in the format dd-mmm-yyyy, that is, 07-may-2006. Do not edit this

line.
exp_date

Note: If the exp_date field contains the text string permanent, the license never expires.
num_lic Number of concurrent licenses for this product license. Do not edit this line.
SIGN=sign SIGN= signature to authenticate this INCREMENT line. Do not edit this line.

Strategically turns off specific licenses based on license feature and signature or
INCREMENT line to be disabled.

Example:
SUPERSEDE_SIGN=5s/gn
SUPERSEDE_SIGN={"CBR_100_SSERVER:0F76 2946 4790 6B67 08E0 65BC 302B E1B6 6ECE

41D6 8AB6 E9C6 FE44 4EB3 9A83 01E4 D405 3E95 74B8 9BC8 7791 BDD3 1385 33F8 9533
95FF A3E4 F461 35B4 251E"}

INCREMENT lines also determine the grouping of licenses in the management console. These groups are known as license
pools. The Citrix vendor daemon creates the license pools based on common attributes, such as product license or version.
When a new poolis created, the console displays and tracks this poolindependently from other license pools. When two or
more attributes are different, the Citrix vendor daemon creates a license pool.

Citrix Attributes in INCREMENT Lines

INCREMENT lines can also include more attributes from Citrix. These attributes provide information about the license, such
as the date on which it was issued or that the license is an upgrade license.
Caution: Do not change or remove these attributes.

Example
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INCREMENT MIPS_ER

dT_CCU CITRIX 2008.0606 permanent 10\,

VENDOR_STRING=;LT=Retail;GP=720;CL=ENT,ADV,5TD,AST;5A=1;0DP=0\ DUP_GROUP=V
ISSUED=06-Jun-2007 NOTICE="Citrix"\ SN=12345: 67890 5TART=6-jun-2007 SIGN="18F8 1546
F605 E3BD 010E 7E4F A4B3 9DE3 BOOE 7937 3337 0180 1FFE C6EB D491

Important items are highlighted in the above example:

e The Product (license feature) appears in blue

e The Customer Success Services expiration date appears in red (Format: YYYY.MMDD)
e The License (user, connection) Count appears in GREEN

Syntax

keyword=value

The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that this attribute is not

editable.
Attribute Description
DUP_GROUP=V This attribute allows license sharing for the same client device.

ISSUED=dd-mmm-yyyy

Date issued.

ISSUER=".."

NOTICE="."

Issuer of the license.

Your company name.

SN=serial_num

START= dd-mmm-yyyy

A number that is used to identify INCREMENT lines.

The date from which you can use a license. The license server cannot use licenses
before their start date.

SUPERSEDE="MPS_ADV_CCU
MPS_STD_CCU ..."

VENDOR_STRING="..."

This attribute appears in the upgrade license file when you move to a higher product
edition. If this attribute appears, this line supersedes all licenses issued before the date
specified in ISSUED= and they become ineffective.

Text string defined by Citrix.

Example of a base license:

INCREMENT CBR_100_SSERVER CITRIX 2016.1201 permanent 10 \

VENDOR_STRING=;LT=Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE;SA=1,0DP=0 \

DUP_GROUP=V ISSUED=18-dec-2005 NOTICE="Citrix" \

SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 06FC\

E1DE B5D5 D793"

Example of a Customer Success Services renewal license containing SUPERSEDE_SIGN:

INCREMENT CBR_100_SSERVER CITRIX 2017.1201 permanent 10 \
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VENDOR_STRING=;LT=Retail;GP=720;MAXBW=2;MLC=0;HA=0;CL=BRSE;SA=1,0DP=0\

DUP_GROUP=V ISSUED=18-dec-2007 NOTICE="Citrix" \

SN=100se200seU SUPERSEDE_SIGN={"CBR_100_SSERVER:1B19 C213 7517 \

CC62 756F 864C 9C93 06FC E1DE B5D5 D793"} SIGN="1D5D 869A 40BE \

D4DB 361D 7897 AFAS FF8B E52A 20BA 5525 01AA F241 6919
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Web Services for Licensing

Citrix License Management Service
Citrix licensing Windows Management Instrumentation (WMI)

Web Services for Licensing

License Server VPX does not support Web Services for Licensing.
Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing to do the following:

e Communicate with the License Server and manage users
e Allocate and install licenses
e Display License Server health, license usage, and other alert messages.

The Citrix Licensing Manager also uses it.

Citrix License Management Service

The License Management Service enables better capacity planning and license management. This service also helps you
avoid prohibited practices:

e Duplication of licenses outside a Disaster Recovery (DR) environment
e Use of legacy licenses for new product versions
e Use of rescinded licenses

This service further alerts the administrator in Citrix Insight Services about duplicate licenses in a Disaster Recovery (DR)
environment. For more information about Citrix Insight Services, see Citrix Insight Services.

The License Management Service uses product telemetry, built into the License Server, to send data to Citrix Insight
Services. The License Management Service is not a Windows service. The first upload occurs one week after the License
Server first starts and subsequent uploads occur every week thereafter. The schedule resets if you reinstall the License
Server. If an upload fails, another attempt is made in 24 hours until either the upload succeeds or you disable the License
Management Service. Citrix might use uploads to help you understand and support your license environment. See Use the
command line to disable or enable the License Management Service.

Important
Your installation of the License Server constitutes your acknowledgement of the License Management Service and your consentto
use the License Management Service. You can disable the License ManagementService anytime after installation.

The License Management Service collects this information:

® License serial numbers
® |License server GUID

® |icenses used count

® Feature name
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I ® Productversions

Citrix Licensing WMI

The WMI service provides access to Citrix Licensing WMI classes. There's a namespace (ROOT\CitrixLicensing) with a few
classes (notably, Citrix_GT_License_Pool) that gives license usage and availability counts. Querying the License Servertoo
often (more than every 15 minutes) might impact performance negatively.
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When you purchase a new Citrix product, your purchase includes a one-year membership in Customer Success Services

(formerly referred to as Citrix Subscription Advantage). This membership entitles you to, among other benefits, any product
updates, including major and minor releases, released during your membership period. For example, if you purchased
XenDesktop, Enterprise edition on July 22, 2015, you are entitled to any updates released for XenDesktop, Enterprise
edition until July 22, 2016. After your initial one-year membership period expires, you may choose to renew your Customer
Success Services membership. After paying Citrix for your renewal, you can use the Citrix Licensing Manager to install your
renewal licenses or you must go to citrix.com and download a license file containing your renewal license.

Important

A Customer Success Services membership and its associated license are distinct from your license to run the product If you do not
renew your Customer Success Services membership, your Citrix products do not stop working; however, you are notentitled to any
software releases after itexpires.

Customer Success Services renewal licenses

Customer Success Services renewal license files contain licenses, known as renewal licenses, that extend your Customer
Success Services membership for a one-year period. These licenses are required to run any new product releases, excluding
hotfixes, that are released during your membership period.

If you do not add the Customer Success Services renewal licenses immediately, your Citrix products do not stop working.
However, you cannot run any new software released during your renewed membership until you have the renewal license
onyour license server.

You do not need to download additional licenses when you install new versions of your products during this membership
period. If Citrix releases a product version after your Customer Success Services membership ends, you must renew your

Customer Success Services membership and obtain a renewal license before you can use the new product version. When
you renew your Customer Success Services membership, you can use the renewal license features of the Citrix Licensing
Manager. For more information see, Update licenses.

Tip
When you download additional license files, you can delete the expired Customer Success Services licenses; however, itis nota
requirement You might wantto keep them to make it easier to identify the upgrade thatis associated with each base license.

You can find out what your Customer Success Services dates are by using:

e (itrix Licensing Manager (see Citrix Licensing Manager)
e License Administration Console on the Dashboard (see License Administration Console)
e Text editorto view the license file

Check for and install Customer Success Services renewal licenses with the Citrix Licensing Manager

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.31


http://docs.citrix.com/en-us/licensing/11-14/citrix-licensing-manager/update-licenses.html
http://docs.citrix.com/en-us/licensing/11-14/citrix-licensing-manager.html
http://docs.citrix.com/en-us/licensing/11-14/manage.html

When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Customer
Success Services renewal licenses.

Based on how you configure it, the Citrix Licensing Manager automatically or manually checks for Customer Success
Services renewal licenses and notifies you or installs the licenses when found.

1. Inthe Citrix Licensing Manager, click the settings icon in the upper right of the UI.
2. Select how you want to be notified and if you want renewal licenses to be automically installed.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting or configure a proxy.
For this feature to work, the License Server must be able to access https://citrixservices.citrix.com.
For more information, see Configure a proxy server.

Tip

You can also configure the ports, the supplemental grace period, and the language on this page.

e Automatically check for Customer Success Services renewal licenses and notify when available: Citrix Licensing
Manager displays a notification. Click on a link to download and install available renewals. Note that this same
notification appears in Studio and Director if they are configured to mange the License Server.

e Automatically check for and install Customer Success Services renewal licenses when available: Citrix Licensing
Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days
stating that renewals have been installed.

e Manually check for Customer Success Services renewal licenses: Select the Update Licenses tab and Check for
Available Renewals. You can check the Update Licenses tab at any time to see a list of licenses installed in the last 30
days.

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.32


https://citrixservices.citrix.com
http://docs.citrix.com/en-us/licensing/11-14/upgrade.html#par_anchortitle_cfa6

Get started, install, and configure the License Server

Feb 26,2018
This article contains the following information:

Licensing steps

Ensure that you have the latest license server

Security considerations

Firewall considerations

Install licensing components for Windows

Use the command line to disable or enable the License Management Service

Import and configure the License Server VPX

Manually install a certificate used by the Citrix Licensing Manager and Web Services for Licensing

Configure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program (CEIP), and Call
Home

Important

We recommend thatyou run the latestversion of the License Server. We do not provide hotfixes for License Server components
and don'tsupportolder License Servers with newer products. The latestversion of the License Server often contains resolutions to
issues appearing in earlier versions. When you upgrade or install new Citrix products, upgrade the licensing components as well.
New License Servers are backward compatible and supportolder products and license files. However, new products often require
the newest License Server to check outlicenses correctly. You can find the latestversion from the Citrix Downloads site.

To see the new features in this release, go to What's new.
Licensing your product includes the following steps:

. Ensure that you have the latest license server version.

. Verify system requirements.

. Install licensing.

. Obtain license files from My Account or if you have a license code, use Citrix Licensing Manager.

. Installyour Citrix product (or, if already installed, restart the Citrix products for the new licenses to be recognized)

. Configure product-side licensing communication settings that were not set during product installation, if applicable. This
configuration includes setting the correct product-edition in the product. Details about these settings are covered in the
product documentation.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For example, if you
purchased Platinum edition licenses, ensure that the edition setting in the product indicates Platinum-not Enterprise or
Advanced.
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Important

The License Server does not require domain membership. You can install the License Server in a workgroup and still perform all licensing functions on
behalf of Citrix products. To manage the License Administration Console or the Citrix Licensing Manager users having Active Directory users or groups,

the users must be part of a domain. Otherwise, use local Windows users.

For an overview of the licensing components and process, see Technical overview and Licensing components.

Ensure that you have the latest license server

1. When upgrading or installing new Citrix products, always have the latest license server. The new license serveris
backward compatible and supports older products and license files. However, new products require the newest license
server to check out licenses correctly. You can install or upgrade the latest version fromthe product media.

For more information about version numbers, see Differences in License Server version numbers.
To find your license server version number

If you are unsure if your license server version is current, you can verify it by comparing your version with the number on the
Downloads site.

On a license server with the Citrix Licensing Manager

1. Start the Citrix Licensing Manager.
2. See the release version in the bar at the top of the page.

On a license server with the License Administration Console

1. For windows: Start the License Administration Console from the programs menu: Citrix > License Administration
Console.
For License Server VPX and remote systems: Open a web browser and go to https://License Server
Name:secureWebPort.

2. Click Administration and select the System Information tab. See the release version in the information list.
On a License Server using the Registry Editor

1. Openthe Registry Editor (Start > Run > regedit).
Important: Use Registry Editor to view the license server information only. Editing the Registry can cause serious
problems that might require you to reinstall your operating system.

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\LicenseServer\Install.

The version number appears in the Version key in the format, for example: 11.14.0.1 build 16100.
On servers running Windows 2008 Server 64-bit, the registry key is

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\LicenseServer\Install
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Security considerations

We recommend that you upgrade the license server to the latest version when you upgrade or install new Citrix products.
New license servers are backward compatible and support older products and license files. Each time a new license server is
released, it might contain better security features than in previous versions.

We also recommend the following security considerations when you configure your environment or use the Licensing
Administration Console.

e Configure the license server environment so that only authorized administrators on a trusted network are permitted to
access the Licensing Administration Console port. You achieve this outcome with an appropriately configured network or
host-based firewall.

e When using the Licensing Administration Console, avoid visiting untrusted websites or clicking untrusted URLSs.

Firewall considerations

Determine if you require a firewall between the license server and any product servers before installing licensing. Firewall
considerations can impact where you install the license server.

The License Server VPX has default ports enabled. To change ports, use the Linux iptables command.
If you have hardware firewalls in your environment, you must create the necessary rules manually.

If there is a firewall between your product and the license server, configure port numbers. This configuration process

entails:

e Determining which port numbers to change. You can change port numbers during the installation process or afterward.

e Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic can flow. Current releases
configure the built-in firewall automatically.

e Changing the product-side settings. Your Citrix product must be configured with the same port numbers as in the License
Administration Console. If you do not change the port number referenced in the product, the product cannot contact
the license server. You can change the product-side settings during and after installation of the product. See your
product documentation for information about these settings.

Install licensing components for Windows

You can install licensing components on a separate, dedicated server or on a server they share with another application.
Alternatively, you can use a web or application server. However, the locations mentioned below are less resource intensive.
If you are running fewer than 50 servers or 10,000 licenses, you can install the License Server on the same server as your
product. To determine if relocation of the License Server to another systemis necessary, monitor CPU and memory load
(Imadmin.exe and CITRIX.exe).

Important

Use the new CitrixLicensing.exe file for all future installations, except for Active Directory deployments. In thatcase, use the .msi.

Ensure thatboth .exe and .msifiles are presentfor the installation.

Install the License Server for Windows and console using the graphical interface

1. Download the License Server from citrix.com and start the License Server installer, CitrixLicensing.exe, as an administrator
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or a member of the administrators group.

2. Follow the installer graphical interface to accept the destination folder.
Licensing components are installed in C:\Program Files\Citrix\Licensing on a 32-bit computer and C:\Program Files
(x86)\Citrix\Licensing on a 64-bit computer.

3. Onthe Configure page, accept or change the default port numbers used by licensing components. Choose whether to
allow the installer to configure the Windows Firewall exception. If needed, you can change the port numbers after
the installation. If you choose to finish the installation without configuring the License Server, restart the
CitrixLicensing.exe installer. You can also use the License Server Configuration tool to configure the settings after the
installation. Open the configuration tool from: C:\Program
Files\Citrix\Licensing\LS\resource\Licensing.Configuration.Tool.exe.
e License server port number is 27000
e Vendor daemon port numberis 7279
e Management console web port is 8082
e \Web Services for Licensing port is 8083

4. The License Server adds the default License Administration Console administrator based on how you are logged on. If
you are in a domain, the License Server adds the installing user (domain\user) as a default License Administration Console
administrator. If you are a local Windows user, the License Server adds the installing user (computer\user) as a default
License Administration Console administrator. The BUILT IN\administrator group, which allows any administrator to
manage licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing to specified users. Any
user that has access to managing the License Administration Console can also manage the Citrix Licensing Manager.

5. Choose to start the License Administration Console or the Citrix Licensing Manager and whether to join the Citrix
Customer Experience Improvement Program.

If you don't choose the Citrix Licensing Manager, or a license from your product administration console, you can still get
your licenses. Go to the citrix.com to obtain the license files for your Citrix products. This procedure is detailed in "Obtain
your license files" below.

Use the Windows command line to install licensing

When using the CitrixLicensing.exe command to install licensing, set properties by adding Property=value on the command
line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges,
choose Start, right-click Command Prompt, and choose Run as administrator.

Note: The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you
are a Citrix Service Provider, you cannot disable CEIP or Call Home.

The following sample command line installs licensing in silent mode. Add the properties you want to set.
Type the command in one line without returns. The following example shows multiple lines due to space limitations.

CitrixLicensing.exe /quiet /Il install.log INSTALLDIR=installdirectory WSLPORT=port_number
LSPORT=port_number VDPORT=port_number MCPORT=port_number CEIPOPTIN=value

Where:

e /quiet specifies a silent (quiet) installation.
e /lIspecifies the log file location
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e |INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.

WSLPORT is the port number used for the Web Services for Licensing. Optional parameter. The default is 8083.
LSPORT is the port number used for the License Server. Optional parameter. The default is 27000.

VDPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.

MCPORT is the port number used for the console. Optional parameter. The default is 8082.

CEIPOPTIN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. The default is ANON.

e DIAG- CallHome

e ANON - CEIP

e NONE

You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.

You can also change the choice made at installation by editing the CITRIX.opt file:
#CITRIX CEIP value

Where value is DIAG, ANON, or NONE

Using the command line to install licensing for an Active Directory deployment

When using the msiexec command to install licensing, set properties by adding Property="value" on the command line
anywhere except between an option and its argument. Clustering is not supported in the .msi.

Note: Ensure that you run the command line with administrator privileges. To start the command prompt with elevated
privileges, choose Start, right-click Command Prompt, and choose Run as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture information about this
operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example shows multiple lines due to space limitations.

msiexec /I ctx_licensing.msi /I*v install.log /qn INSTALLDIR=/nstalldirect ory LICSERVERPORT=port_number
VENDORDAEMONPORT=port_number MNGMTCONSOLEWEBPORT=port_number
WEBSERVICELICENSINGPORT=port_number CEIPOPTIN=value

Where:

e /I*vis the location of the setup log. Optional parameter.
e /qgn specifies a silent (quiet) installation.
INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.
LICSERVERPORT is the port number used for the License Server. Optional parameter. The default is 27000.
VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.
MNGMTCONSOLEWEBPORT is the port number used for the console. Optional parameter. The default is 8082.
WEBSERVICELICENSINGPORT is the port number used for the Citrix Licensing Manager. Optional parameter. The
default is 8083.
e CEIPOPTIN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. The default is ANON.
e DIAG-CallHome
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e ANON - CEIP
o NONE
You can change the CEIP and CallHome choice using the Citrix Licensing Manager.

You also can change the choice made at installation by editing the CITRIX.opt file:
#CITRIX CEIP value
Where value is DIAG, ANON, or NONE

Use the command line to disable or enable the License Management Service

The License Management Service operates automatically within the License Server and allows for license management and
support. We recommend using the License Management Service for management of your license environment, but you can
disable it any time afterinstallation. For more information, see "Citrix License Management Service" in Technical overview.

Syntax:

ctx_license_management_service.exe (-enable | -disable | -query)

Where:

-enable enables license management. The first upload to Citrix occurs seven days afteryou install the License Server.

-disable disables license management. We recommend that you use the License Management Service to manage your
licensing environment.

-query displays the current configuration.

Import and configure the License Server VPX

The Citrix License Server VPX is distributed as a virtual machine system configured in .xva format.
To import License Server VPX using XenCenter

1. Open XenCenter, click the server on which to import the License Server VPX, and select Import.

2. Browse to the location of your package and choose the .xva package.

3. Choose a Home Server for your virtual machine. This Home Server is the server on which the virtual machine starts
automatically. Alternately, you can click a XenServer pool and the virtual machine automatically starts on the most
suitable host in that pool.

4. Choose a storage repository for the virtual disk. The repository must have a minimum of 8 GB of free space.

5. Define network interfaces. The License Server VPX communicates on a single virtual NIC. Choose a network that is
accessible to the Citrix Servers to which you want to provide license services.

Afteryou import the virtual machine, it appears inside your XenCenter management console. You can restart the virtual
appliance in XenServer by right-clicking on its name and choosing Start.

Configure the License Server VPX for first use

Afterimporting the License Server VPX, you have a fully functional Citrix License Server on your XenServer pool. The first
time you start the License Server, a set up wizard opens to configure networking.

1. Afterthe wizard opens, create a strong root password for administrators.
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2. Specify a hostname for the License Server VPX.
Note: Most Citrix license files are tied to the case-sensitive hostname of your License Server.

3. Specify a domain for the License Server VPX.

4. Specify whetherto use DHCP as your network type. Choose y to obtain network information automatically. Otherwise,
choose n, and type the required network information.

5. Specify a License Administration Console user name and password for the licensing service.

6. Choose whether to enable the Customer Experience Improvement Programand Call Home. For more information, see
About the Citrix Customer Experience Improvement Program (CEIP).

7. Choose whetherto add the VPX License Server to Active Directory domain. If you do, after the setup is complete, follow
the instructions to generate and install the key tab file to complete the configuration.

Important: If you don't configure Active Directory, then Citrix License Manager, Studio, and Director integration are
unavailable.

Configure licenses froma web-based interface, available on port 8082.

If you make a configuration error, log on to the appliance as root with the password you specified. Type the command
resetsettings.sh orreset_ceip.sh to rerun the set up wizard.

resetsettings.sh command

resetsettings.sh provides the option to retain or delete historical data files while resetting the Licensing Server VPX
configuration. You can fully reset the configuration by deleting all historical data collected until that time or partially reset
the configuration by retaining the historical data.

As root, run the following script and make your choices:

# resetsettings.sh

reset_ceip.sh command

reset_ceip.sh provides the option to reset the Customer Experience Improvement Program (CEIP) options you chose during
the original configuration. This command resets only the CEIP settings and retains all other settings.

On VPX, do not modify the CITRIX.opt file. As root, run the following script and make your choice of CEIP [1L.DIAG 2ANON
3. NONE].

#reset_ceip.sh
Export the database for use in a different License Server VPX

Use the migrate_historical_data.sh script to migrate the historical data to a newer Licensing Server VPX. The script
provides options to back up and restore historical data.

Run this script as root.
This example procedure migrates the data from VPX_O to VPX_N.
1. Runthe command # migrate_historical_data.sh -b on VPX_O to create a backup file /tmp/historical_data.tar.

2. When VPX_Nis running, copy or move the /tmp/historical_data.tar file to VPX_N using any file transfer protocol. For
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example, scp.
3. Runthe # migrate_historical_data.sh -r /directory command on VPX_Nto restore the data. Where directoryis the
directory in which historical_data.tar resides.

Generate and install the keytab file

1. Use the ktpass.exe utility froma Windows server OS (toolkit)that is connected to the same domain. Type the command
on one line without returns. The following example shows multiple lines due to space limitations.

ktpass.exe -princ HTTP/host FQDN@DOMAINREALM -mapuser domain_account -pass password-out filepath -
ptype KRB5_NT_PRINCIPAL
Where:

-princ HTTP/hostFQDN@DOMAINREALM specifies the principal name:
hostFQDN is the Fully Qualified Domain Name of the License Server VPX.
DOMAINREALM is the Active Directory domain typed in CAPITAL LETTERS.

-mapuser domain_account specifies a user in the domain that can be used to bind to Active Directory.
Recommendations: Create and use a service account in the domain specifically for keytab creation. Create the
account with the name of the VPX server to which the service principal name (SPN) will be mapped.

-pass passwordspecifies any strong password that fulfills the password requirements of your domain.

-out filepathspecifies the path where the generated keytab file is saved.

-ptype KRB5_NT_PRINCIPAL specifies the principal type. This is the only supported principal type.

Example:

ktpass.exe -princ HTTP/VPXHOST.example.domain.com@EXAMPLE.DOMAIN.COM -mapuser administrator -pass password
—out C\example.keytab -ptype KRB5_NT_PRINCIPAL

1. Rename the generated keytab file to ctx_http.keytab.

2. Securely copy the generated keytab file using secure copy tools (for example, WinSCP or FileZilla) to this path on the
License Server VPX:
/opt/citrix/licensing/LS/conf/ctx_http.keytab

3. To access the Citrix Licensing Manager, open https://VPXHOST.example.domain.com:8083/

4. To bind the Active Directory, log on using the user configured in the command in step 1.

5. To configure and administer other domain users, log on to the Citrix License Administration Console
https://VPXHOST.example.domain.com:8082

6. Add and remove Active Directory users. If you have any issues generating and installing the keytab file, see Troubleshoot.

Important

® |icense Server VPX doesn'tsupportActive Directory groups.

® Because Kerberos authenticates the Active Directory users, the keytab file generation is crucial.

® As per Kerberos rules, you mustmap a unique user againstthe principal name created using ktpass.exe. For more information,
see https://technetmicrosoftcom/en-us/library/cc753771(v=ws.11).aspx.
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Obtain license files with the License Administration Console

10.
11

12.
13.
14.
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From a web browser, go to https://Is:8082.

Click Administration and Vendor Daemon Configuration.

Click Import License.

Click the citrix.com link.

On the My Account page, type your user ID and password.

Select All Licensing Tools.

Fromthe main menu, select Allocate.

Follow the process to allocate and generate your file.

Select the licenses you want to download, click Download, and save the file to and save the file to a temporary
directory.

In the License Administration Console on the Import License File page, browse to the license file.

If you copied the file directly to the MyFiles directory, orif a file having the same name exists on the License Server,
select Overwrite License File on License Server.

Click Import License.

Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses when the License Server reads the licenses.

Move license files from an older License Server VPX version

This procedure moves only the license files. Reconfigure all the users on the new License Server. Ensure that the license files
that you move have the correct ownership and permissions.

1

5.

Back up the license files fromthe old Citrix License Server VPX to a network share. You can use the script located in
/usr/local/bin.
All the *.lic license files from: /opt/citrix/licensing/myfiles except citrix_startup.lic

. Close the old License Server
. Spin up the new Citrix License Server VPX using the same binding as the older one.

The binding might be a MAC address or hostname or IP Address specified in the SERVER line of the license files.

. Restore the backed-up license files fromthe Network Share to the new License Server. Restore the files to:

/opt/citrix/licensing/myfiles with the file ownership as ctxlsuser:imadmin (usergroup) and permission as 644.
Run this command as ctxIsuser: /opt/citrix/licensing/LS/Imreread -c @localhost

Manually install a certificate used by the Citrix Licensing Manager and Web Services for Licensing

Note

Use this procedure if you are a Director or Studio administrator who doesn'twantto use the self-signed certificate thatis generated
during installation.

To install a certificate, there are three steps:

1
2.

Obtain a .pfx file, which contains the certificate and private key. You can use one of two methods to obtain the .pfx file.
Extract the certificate and private key from the .pfx file.
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. Install the certificate and private key on to the License Server.

Step 1, method 1 - Obtainthe .pfx file using a domain certificate

Logonto a serverin the domain, open the MMC, and follow these steps:

1
. Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer account > Local computer.

10.
11.

12.

13.

Create a directory c:\Is_cert to hold the exported .pfx file.

In the left pane under Certificates, right-click Personal and choose All Tasks > Request New Certificate, and then click
Next.

. Inthe Certificate Enrollment Policy wizard, choose Active Directory Enrollment Policy, and click Next. Select the check

box next to Computer, and select Details to the right.
Select Properties and on the General tab, type a friendly name and description.

. Onthe Subject tab, under Subject Type, choose Common name fromthe Type drop-down menu. Type a friendly name in

the text box, click Add, and then click Apply.

. Onthe Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment to the

Selected options box.

On the Extended Key Usage drop-down menu, add Server Authentication and Client Authentication to the Selected
options box.

On the Private Key tab and under the Key options drop-down menu, ensure that the Key size is 2048. Select the Key
Exportable check box, and then click Apply.

On the Certification Authority tab, ensure that the CA check box is selected, and click OK > Enroll > Finish.

In the Certificates console, select Personal > Certificates, click the certificate you built. Select All Tasks > Export > Next,
and select the Yes, Export the Private Key radio button and Next.

Under Personal Information Exchange - PKCS #12(PFX), select the check box to include all certificates, click Next, create
a password, and click Next.

Click Browse, navigate to C:\Is_cert and type server.PFX, and then follow the wizard to finish.

Step 1, method 2 - Obtain the .pfx file sending a request to a Certificate Authority (CA)

T

L

hese steps might vary based on your Certificate Authority.

Log on to the License Server, open the MMC, and follow these steps:

1. Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer account > Local
computer.

2. Inthe left pane under Certificates, right-click Personal and choose All Tasks > Advance Operations > Create
Custom Request, and click Next.

3. Inthe Certificate Enrollment Policy wizard, choose Proceed without enrollment policy under Custom Request,
and click Next.

4. Onthe Custom request screen, choose (No template) CNG key from the drop-down menu and PKCS#10 for the

Request format, and click Next.

On the Certificate Information screen, choose Details and click Properties.

On the General tab, type a friendly name and description.

On the Subject tab, under Subject name, choose Common name and type a value in the text box.

On the Extensions tab, choose Key usage fromthe drop-down menu, add Digital signature and Key

encipherment.

9. Onthe Extensions tab, choose Extended Key usage from the drop-down menu, add Server Authentication and

Client Authentication.
10. Onthe Private Key tab, under Cryptographic Service Provider, choose RSA, Microsoft Software Key Storage
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Provider (the default). From the Key options drop-down menu, ensure that the key size is 2048, select the Key
Exportable check box, and then click Apply.
11. Save the file to a .req file, submit the .req file to a Certificate Authority (CA), and save the .cer file.
2. Inthe MMC, under Certificates, right-click Personal and choose All Tasks > Import. In the Import wizard, select the
cerfile.
3. Create a directory c:\Is_cert to hold the exported .pfx file.
4. Inthe Certificates console, select Personal > Certificates, and click the certificate you just imported. Select All Tasks
> Export > Next, and select the Yes, Export the Private Key radio button and Next.
5. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all certificates, click Next,
create a password, and then click Next.
6. Click Browse, navigate to C:\Is_cert and type server.PFX, and then follow the wizard to finish.

Step 2 - Extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key from a .pfx file.

Important: The version of OpenSSL shipped with the License Server does not support extracting certificates and private
keys. For information about downloading OpenSSL, go to www.openssl.org. Citrix recommends installing OpenSSL on a
separate workstation to performthese steps:
1. Navigate to the <openssl| directory>\bin folder.
2. Runopenssl pkes12 -in C:\Is_cert\server.pfx -out server.crt -nokeys
Note: The License Server uses only the .crt certificate format.
3. Type the password created during the export process (password).
4. Run openssl pkes12 -in C\Is_cert\server.pfx -out server.key -nocerts -nodes
5. Type the password created during the export process (password).

Step 3 - Install the .crt and .key files on the License Server

Windows - Web Services for Licensing:

1. Copy the server.crt and serverkey created above to cd \programfiles
(x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.
2. Restart the Citrix Web Services for Licensing service.

Windows - License Administration Console:

1. Copy the server.crt and serverkey created above to c:\Program Files (x86)\Citrix\Licensing\LS\conf.
2. Restart the Citrix Licensing service.

VPX:

1. Copy the server.crt and server.key created above to /opt/citrix/licensing/LS/conf/ and
/opt/citrix/licensing/WebServicesForLicensing/Apache/conf/.

2. etc/init.d/citrixlicensing stop

3. etc/init.d/citrixlicensing start

Configure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program
(CEIP), and Call Home

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure a proxy server, requests to
download licenses and upload Call Home data are sent through a proxy server.
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Important

Citrix Licensing components requiring outward bound web communications can inherit network proxy settings using Windows
automatic proxy detection. We do notsupportauthenticated proxies. For more information about Windows automatic proxy

detection, see WinHT TP AutoProxy Functions.

Configure a proxy server manually

1. Edit the SimpleLicenseServiceConfig.xml file, which is in the <citrix Licensing>\WebServicesForLicensing directory.
2. Add a line of xmlto the file in the format <Proxy>proxy server name:port number</Proxy>
Important: The xml tags are case-sensitive.

Sample
<Configurations>
<EncoreConfiguration>
<SamplingPeriod>15</SamplingPeriod>
<RetentionTime>180</RetentionTime>
<Enabled>true</Enabled>
</EncoreConfiguration>

<Proxy>10.211.55.5:808</Proxy>

</Configurations>
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Upgrade

Feb 26,2018
Each time you upgrade your Citrix product, also upgrade the Citrix License Server. Each time a new License Server is released,

it might contain better security, fixes to known issues, and so on.

Sometimes, new versions of the Citrix product are not compatible with older versions of the License Server. New versions of
the License Server are compatible with older versions of the product and old licenses.

Customer Success Services members are eligible to version upgrade to the latest release of Citrix products and upgrade
existing licenses to the license system used by these products.

Version upgrade means the movement from any previous version of a product to the newest version of the product. For
example, moving from XenDesktop 5.6 to XenDesktop 7 x.

Edition upgrade means the purchase of a higher edition level of a product. For example, you now have Enterprise Edition
and you purchase an upgrade to Platinum Edition.

Warning

Upgrades are notsupported for License Server VPX. See Move license files from an older License Server VPX version and Export
historical usage data.

Upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward compatible and supports
older products and license files. However, new products require the newest License Server to check out licenses correctly.
You can install or upgrade the latest version from the Citrix website (Downloads page).

Upgrade your licensing components before upgrading your product, if necessary.
Uninstall any versions of Citrix Licensing older than version 11.12.1 before installing this version.

Use the new CitrixLicensing.exe file for all future installations and upgrades, except for Active Directory deployments. In
that case, use the .msi. Ensure that both .exe and .msi files are present for the installation.

Unsure which version of the License Server you have? See Ensure you have the latest license server.

Forinformation about system requirements, see System requirements.

Important

To avoid the failure of any subsequent License Server upgrades: Ensure thatwhen you installed your License Server, you
successfully configured it with the postinstallation License Server Configuration tool or uninstalled your previous License Server.
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To upgrade the License Server

Download the license components on the Citrix website (Downloads page), start the License Server installer
(CitrixLicensing.exe) as an administrator, and follow the graphical interface.

To upgrade the License Server from your product media

If you use the product media foryour installation, you might have to enable some functionality by using the Citrix Licensing
Manager afteryour installation. For example, use the Citrix Licensing Manager to enable Customer Success
Services renewals.

1. Fromyour License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
3. Navigate through the Setup screens to Citrix Licensing and follow the instructions.

To upgrade the License Server from the command line

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges,
choose Start, right-click Command Prompt, and choose Run as administrator.

Note: The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you
are a Citrix Service Provider, you cannot disable CEIP or Call Home.

You cannot change ports during a command line upgrade.
The following sample command line installs licensing in silent mode.
CitrixLicensing.exe /quiet /I install.log INSTALLDIR=/nstalldirectory CEIPOPTIN=ANON

e /quiet specifies a silent (quiet) installation.

e /lIspecifies the log file location

e |INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.

e CEIPOPTIN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. The default is ANON.
e DIAG- CallHome
e ANON - CEIP
e NONE

You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.

Upgrade licenses for your edition

To run a higher edition of a Citrix product (for example, XenDesktop Enterprise to Platinum), purchase an upgrade license
and add it to the License Server. Also change the product edition setting in the product user interface. It's best to change
the product edition setting when there are few connections to the affected servers or redirect connections to another
computer. When you change the product edition setting, restart the product server for changes to take effect. See the
product documentation for changing the edition setting. If you add the upgrade license to the License Server before you
set the edition to the new edition, the Citrix product stops accepting new connections.

I Note
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Licenses from old product editions display on the Dashboard of the License Administration Console even though they are no longer
valid. If you do notremove obsolete or unnecessary license allocations, you mightsee persistentalerts regarding the Customer
Success Services expiration dates of these licenses. You cannotturn off these alerts. The only impact of leaving obsolete license
allocations on License Servers is thatyou continue to receive these alerts. If you wantto remove the licenses, see "Delete license

files" in Administration withouta console.

To upgrade edition licenses:

Froma web browser, go to http://www.citrix.com.

Click Log In and enter your user ID and password.

Select All Licensing Tools.

Fromthe main menu, select Upgrade.

Follow the site options and instructions for upgrading your product edition licenses.

Either download or order new media. An email message provides you with instructions to return to citrix.comto allocate
or receive more feature licenses.

7. Log onto www.citrix.comto allocate your licenses, generate a license file, download the license file to your License
Server, and reread the file.
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Prerequisites to obtain your license files

Feb 26,2018
Afteryou install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

e Studio in XenApp and XenDesktop. For more information, see Licensing in the XenApp and XenDesktop documentation.
e (ijtrix Licensing Manager.

e License Administration Console.

e citrix.com.

Before going to the Citrix website, you need the following information at hand:

e Youruser ID and password for My Account. You can register for this password on My Account.

e The license code. Find this code: at My Account on citrix.comorin an email you receive from Citrix.
Note: If you cannot locate these items, contact Citrix Customer Service.

e The Host ID of the server on which you installed the licensing components. The entry field for this name is case-
sensitive, so ensure that you copy the name exactly as it appears on the computer.
You can find the license server host name and MAC address (Ethernet) in the License Administration Console in the
Administration area on the System Information tab. You can also run the hostnamecommand at a command prompt on
the license server.

e How many licenses you want to include in the license file. You do not have to download all the licenses you are
entitled to at once. For example, if your company purchases 100 licenses, you can allocate and download only 50 now.
Later, you can allocate the rest in another license file. You can have more than one license file.
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Citrix Licensing Manager

Feb 26,2018
The Citrix Licensing Manager enables the following features on a License Server using a simple web interface:

In the latest build :

o Simplify data export by allowing you to select all products, all license models, and all Customer Success Services
(Subscription Advantage) dates. Previously, you had to select a specific product, model, and Customer Success Services
date range. (Not available in License Server VPX.)

In previous builds:

e Enable and disable the supplemental grace period. (Not available in License Server VPX.)
e Modify these ports:
e License Server (default 27000) (Not available in License Server VPX.)
e Vendor Daemon (default 7279) (Not available in License Server VPX.)
e Web Services for Licensing (default 8083)
e Configure historical data retention by selecting a retention period. Default data retention is 180 days.
Displays the License Server version in the top bar of the screen. If you click the down arrow, the hostname, Ethernet
address, and IPvr address appear. (Not available in License Server VPX.)
Simplified installation of license files on the License Server using a license access code or downloaded file.
Display details of licenses after they are installed.
Configure Citrix Customer Experience (CEIP) and CallHome at any time.
Retry failed citrix.com and Customer Experience Improvement Program uploads.
Configure Customer Success Services renewal license actions. You can specify whether to check automatically or
manually for renewal licenses and whether you want notification of renewal licenses or the licenses installed. For more
information on configuring this feature, see Check for and install Customer Success Services renewal licenses with the

Citrix Licensing Manager.

e Store and export historical usage reports fromthe License Server on which the toolis installed. You can specify a date
range for the historical usage data and export it to a CSV file. The CSV file provides daily usage information including the
number of licenses in overdraft. For information about exporting historical usage data, see Export historical usage data
by using the Citrix Licensing Manager.

e |mportant notifications of license availability, expiration, and other conditions. Use the bellicon at the top of the Citrix
Licensing Manager screen to display notifications.

The Citrix Licensing Manager operates automatically within the License Server for Windows. The Citrix Licensing Manager
available with the License Server VPX if you configure Active Directory and install the keytab file..

Related information

Install
Historical usage
Update licenses
Settings
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Install licenses

Feb 26,2018
Install licenses (Builds 23101, 22103, 21103, and 20104 and License Server VPX build 19800)

Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download
licenses:

e The License Server requires internet access or configuration with a proxy server.

e Afteryou click Allocate and Download, you cannot cancel it. If the Allocate and Download fails, use My Account at
citrix.com.

e The Citrix Licensing Manager allocates most license access codes but doesn't support redownloading or reallocating of
license files. You can return licenses on citrix.comand use the Citrix Licensing Manager to allocate themagain. For
redownloading, use My Account.

e If yourename the license server, you must reallocate any license files allocated under the old license server name.

e The Citrix Licensing Manger gives you the option of choosing how to obtain your licenses:

e Use license access code
e Use downloaded license file - Builds 22103 and 21103 displays information about the licenses when you use
the license access code and download license file methods.

Inthe Start menu, click All Programs > Citrix > Citrix Licensing Manager or from a remote
machine, https://licenseservername:8083.

Use license access code:
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Historical Use Install Licenses Update Licenses

Install Licenses

Choose the method to install licenses on the License Server.

License Server Information

Hostname  lictest.net P Address  10.61.45
You can choose to install licenses by using the license access code or a license file (lic).
(®) Use license access code () Use downloaded license file

License Access Code

MP5-PLT-CCU-5A

Display Licenses

License Entitlements

Product Name Quantity/Available Already Used Action/Progress
Citrix XenApp Platinum | Concurrent 100 /100 0

1. Select Use license access code and type the license access code (which is supplied in an email from Citrix) and choose
Display Licenses. Your license entitlements display and you can choose which licenses and the quantity to install.

2. Select a product fromthe displayed list, type the number of entitlements to install, and choose Install. To select more
than one product, choose a product, click Install, choose the next product, click Install, and so on. They are processed in
order. Afteryou install all the licenses for a specific license access code, you cannot use that license access code again. If
you must perform more transactions with that code, log onto My Account.

3. To display the newly downloaded licenses, refresh the License Administration Console.
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(®) Use license access code () Use downloaded license file

License Access Code

MPS-PLT-CCU-5A

Display Licenses

License Entitlements

Product Name Quantity/Availzble Already Used Action/Progress
Citrix ¥XenApp Platinum | Concurrent 100 /100 0 + Installed
Product{#)-Type SA Date(YYYY.MMDD) Available Expiry Date

witrix XenApp Platinum | Concurrent-Retail

20171201 100 01-dec-2017

.

Use downloaded license file:
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Install Licenses

Choose the method to install licenses on the License Server.

License Server Information

Hostname lictest.net FAddress 1006145

You can choose to install licenses by using the license access code or a license file (lic).
() Use license access code (®) Use downloaded license file
License File

Installed License Details

Product{#)-Type SA Date(YYYY.MMDD) Available Expiry Date

witrix XenApp Enterprise | Concurrent User-Retail

20181201 1 01-dec-2018

1. Select Use downloaded license file, choose a file, and check the check box if you want to replace and older file with
the same name.

2. Click Import. The Citrix Licensing Manager displays information about the licenses.

3. If yourlicense file is successfully uploaded to the License Server, a message displays. To display the newly downloaded
licenses, refresh the License Administration Console.

Install licenses using the Citrix Licensing Manager build 19005
Not available in License Server VPX.

Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download
licenses:

e Afteryou select Allocate and Download, you cannot cancelit. If the Allocate and Download fails, use My Account at
citrix.com.

e The Citrix Licensing Manager allocates only retail licenses (no evaluation or demo licenses) and doesn't support
redownloading or reallocating of license files. For those features, use My Account.

e |f you rename the license server, you must reallocate any license files allocated under the old license server name.

1. Inthe Start menu, select All Programs > Citrix > Citrix Licensing Manager or froma remote
machine, https://licenseservername:8083.
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2. If youwant to change the port or language, click the Settings icon on the menu bar at the top of the page. Make
changes and click Save.

3. Select Allocate Licenses, type the license access code (which is supplied in an email from Citrix) and click Display
Licenses.

4. Select a product fromthe displayed list and click Allocate and Download. To select more than one product, choose a
product, click Allocate and Download, choose the next product, click Allocate and Download, and so on. They are
processed in order. Afteryou allocate and download all the licenses for a specific license access code, you cannot use
that license access code again. If you must perform more transactions using that code, log on to My Account.

5. To display the newly downloaded licenses, refresh the License Administration Console.
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Historical usage
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The Citrix Licensing Manager stores and exports historical usage reports fromthe License Server on which the toolis

installed. You can specify a date range for the historical usage data and export it to a CSV file. The CSV file provides daily
usage information including the number of licenses in overdraft.

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Historical Use

Use these filters to export a License 5enver Product usage report for the specified time period 35 a csv file.
Product & Edition Model
Citrix Start-up License (CITRIX) ~ Server W ‘
Customer Success Services Date Start Date End Date
2038.0101 v 01/19/2018 [#] ‘ 01/19/2018 [#]

To export historical usage data

1. Logonto the Citrix Licensing Manager hosted on the License Server: Type this URL into a browser on a system having
access to the License Server.

http://License-Server-Hostname:8083/

2. Using the drop-down menus, select the product and edition, the license model, and the date range (larger the better) to

gather the history.
3. After making your selections, click Export, and the browser download dialog displays.
4. Using the Save drop-down menu, select Save As to save the exported.CSV file.

Starting with build 23201, you can choose All if you have multiple Customer Success Services dates. For older builds, If you
have multiple Customer Success Services dates, export data for each date. Use the combined data to determine your
complete usage.

The default retention period is 180 days.
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Update licenses
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You can check for available Customer Success Services renewal licenses. When licenses are available, the list of licenses,

quantity, and Customer Success Services date display on this screen. You can download and install the licenses. This screen
lists any licenses installed in the last 30 days.

Update Licenses

License Server Information

Hostname cc-dc02 IF Address  10.61.44.85

Check for Available Renewals

Customer Success Services renewal licenses available

Product Name Quantity (55 Date Action

Citrix XenDesktop Platinum | User/Device 1 2018.1201 Download and Install

Customer Success Services renewal licenses installed in the last 30 days

Mo renewal licenses were installed
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Settings

Feb 26,2018
Display the Settings by clicking the Settings gearicon on the top of the screen. There are two types of settings:

e Server configuration
e Usage & statistics

This article describes the Settings screens for Windows and VPX.

Server configuration for Windows
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Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Settings

Server Configuration Usage and Statistics

Configured Ports

License Server Port @ 27000 &
Vendor Dasmon Port @ 7279 &
Weh Services for Licensing Port @ 8083 2

Customer Success Services Renewals ()

O Automatically check for Customer Success Services renewal licenses and notify when available.
@ Automatically check for and install Customer Success Services renewal licenses when available.

O Manually check for Customer Success Services renewal licenses.

Supplemental Grace Peried

Start the 15-day supplemental grace period when the reqular license cansumption limit is reached. .

Language English &

Configure port numbers
You can edit the three default ports:

e License Server. This port number is used by the License Server Manager. License Server Manager handles the initial
communication among the products, starts the vendor daemon, and relays check out and check in requests to the
vendor daemon. By default, this port number is 27000.

e Vendor Daemon. This port number is used by the CITRIX vendor daemon. The vendor daemon is responsible for the core
operations of the License Server, including license allocation. By default, this port numberis 7279. However, if you have a
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firewall or if the number is already in use, you might need to change the port number.

e Web Services for Licensing. Port used by the Web Services for Licensing. Web Services for Licensing hosts the Citrix
Licensing Manager, so users connecting to Citrix Licensing Manager use this port. Director and Studio use this port to
communicate with the License Server using Web Services for Licensing. By default, this port number is 8083.

Check for and install Customer Success Services renewal
When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Customer
Success Services renewal licenses.

Based on how you configure it, the Citrix Licensing Manager automatically or manually checks for Customer Success
Services renewal licenses and notifies you or installs the licenses when found.

1. Inthe Citrix Licensing Manager, click the settings icon on the upper bar of the Ul.
2. Select how you want to be notified and if you want renewal licenses to be installed automatically, and then click Save.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting or configure a proxy.
Forthis feature to work, the License Server must be able to access https://citrixservices.citrix.com.

e Automatically check for Customer Success Services renewal licenses and notify when available: Citrix Licensing
Manager displays a notification. Click on a link to download and install available renewals. Note that this same
notification appears in Studio and Director if they are configured to mange the License Server.

o Automatically check for and install Customer Success Services renewal licenses when available: Citrix Licensing
Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days
stating that renewals have been installed.

e Manually check for Customer Success Services renewal licenses: Select the Update License tab and Check for
Available Renewals. You can check the Update License tab at any time to see a list of licenses installed in the last 30
days.

Supplemental grace period
Specify whether to start the 15-day supplemental grace period when the regular license consumption limit is reached. For
more information, see "Supplemental grace period" in the Technical overview article.

Change the default and display language
You can change the default language of the Citrix Licensing Manager display. The default applies to all console users.
Available languages include:

Chinese (Simplified)
English

French

German

Japanese

Spanish

Usage & statistics

This section enables the following:

e Configure how you share usage statistics with Citrix.

© 1999-2017 Citrix Systems, Inc. All rights reserved. p.59


https://citrixservices.citrix.com
http://docs.citrix.com/en-us/licensing/11-14/technical-overview.html

e Know the status of your uploads. If uploads fail, information appears with suggestions to fix the issues.
e Set the period to retain historical usage information. The default is 180 days.

Lic o
1114.01 build 22100

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Settings

Server Configuration Usage and Statistics

Share usage statistics with Citrix

Help us improve Citrix products by providing License Server and basic usage statistics. (1)

(@ Allow Citrix Insight Services to safely collect basic usage and statistical information to
~ betterunderstand customer usage.

, 5end anenymeus statistics and usage information te the Citrix Customer Experience
Improvement Program (CEIF).

y Do notsend any data to Citrix.

Upload information

Provides status for the last Citrix Customer Experience Improvement Program (CEIF). Call Home, or Citrix Service Provider
Program upload.

Last successful upload 3/21/2017, 10:02:07 AM

Historical Usage

Retention Period @ 180 Days &

Share usage statistics

The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to
improve your product experience. You can participate in the programs anonymously, choose to be identified, or decline to
participate.
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Important

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can
change the settings, butyou cannotdisable CEIP or Call Home.

Upload information
This section provides status for the last CEIP, Call Home, or Citrix Service Provider upload. If the upload fails the Citrix
Licensing Manager displays troubleshooting information.

Upload information
Provides status for the last Citrix Customer Experience Improvement Program (CEIP), Call Home, or Citrix Service Provider Program upl

Last successful upload 03/08/2017, 11:54:52

@ An upload to cis.citrix.com failed due to Error code #5 - network error while connecting to cis.citrix.com. An automatic retry is
attempted in 24 hours, but you can click Retry now to try again. If this message doesn't resolve itself, see the troubleshooting steps
below.

~ Steps to troubleshoot

= To verify connectivity, open a web browser from the License Server and go to https://cis.citrix.com.
« Are firewalls blocking access to https://cis.citrix.com port 4437
« |s a proxy server required? Configure Citrix Licensing Manager accordingly. See docs.citrix.com for details.

= You can review the transmission log available at
C\Program Files(x86)\Citrix\licensing\ls\Logs\logs_ctxuploader.txt

+ If the error doesn’t resolve, contact Citrix Support.

Historical usage retention

Set the amount in days to retain your License Server usage information.

Server configuration for VPX

Note: The VPX Ul still refers to Customer Success Services as Subscription Advantage.
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Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Server Configuration

HTTPS Port (default 8083) Language Retention Period

8083 ‘ ‘ E= English v| ‘ 180 Days v

Days to retain historical usage data.

Subscription Advantage Renewals

(@ Automatically check for Subscription Advantage renewal licenses and
~ notify when available. Learn More

y Automatically check for and install Subscription Advantage renewal
licenses when available

) Manually check for Subscription Advantage renewal licenses

Share usage statistics with Citrix

Help us improve Citrix products by providing License Server and basic usage statistics. (D)

 Allow Citrix Insight Services to safely collect basic usage and statistical information to
better understand customer usage.

(@) Send anonymous statistics and usage information to the Citrix Customer Experience
~ Improvement Program (CEIP).

y Do not send any data to Citrix.

Cancel

Configure port numbers

e Web Services for Licensing. Port used by the Web Services for Licensing. Web Services for Licensing hosts the Citrix
Licensing Manager, so users connecting to Citrix Licensing Manager use this port. Director and Studio use this port to
communicate with the License Server using Web Services for Licensing. By default, this port number is 8083.

Change the default and display language
You can change the default language of the Citrix Licensing Manager display. The default applies to all console users.
Available languages include:

e Chinese (Simplified)
e English
e French
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e German
e Japanese
e Spanish

Historical usage retention
Set the amount in days to retain your License Server usage information.

Check for and install Customer Success Services renewal (formerly called Subscription Advantage)
When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Customer
Success Services renewal licenses.

Based on how you configure it, the Citrix Licensing Manager automatically or manually checks for Customer Success
Services renewal licenses and notifies you orinstalls the licenses when found.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting or configure a proxy.
For this feature to work, the License Server must be able to access https://citrixservices.citrix.com.

Note: The VPX Ul still refers to Subscription Advantage.

e Automatically check for Subscription Advantage renewal licenses and notify when available: Citrix Licensing
Manager displays a notification. Click on a link to download and install available renewals. Note that this same
notification appears in Studio and Director if they are configured to mange the License Server.

e Automatically check for and install Subscription Advantage renewal licenses when available: Citrix Licensing
Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days
stating that renewals have been installed.

e Manually check for Subscription Advantage renewal licenses: Select the Update License tab and Check for Available
Renewals. You can check the Update License tab at any time to see a list of licenses installed in the last 30 days.

Share usage statistics

The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to
improve your product experience. You can participate in the programs anonymously, choose to be identified, or decline to
participate.

Important

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can
change the settings, butyou cannotdisable CEIP or Call Home.
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License Administration Console

Feb 26,2018
The License Administration Console lets you manage and monitor your Citrix licenses through a web browser.

Use the Dashboard to:
e Monitor licenses, license activity, and alerts
Use the Administration area to:

Administer licenses

Configure console users
Configure alerts

Import licenses

Log license management activities
Secure the console server

View systeminformation

Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the
Administration area requires administration privileges and is password-protected.

Openthe console ona Windows computer

To open the License Administration Console on the computer on which it is installed:
Fromthe Start menu, choose All Programs > Citrix > License Administration Console.
Openthe console onaremote server or cluster

Navigate your browser to one of the following URL options:

e https://License server name:Web service port
e https://Client access point name:Web service port
e https://IP:Web service port

Where:

License server name is the name of your license server

Client access point name is the name given to the client access point during cluster configuration
IP is the IP address of the license server

Web service port is the port number for the console web service

The default web service port for the console is 8082.

Update the License Administration Console Ul

If you added license files with the console, you must update the console Ul after removing those files.

1. Start the console and click Administration.
2. Logon as an administrative user and click the Vendor Daemon Configuration tab.
3. Select the Citrix vendor daemon fromthe list.
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4. Edit the contents of License File or Directory to remove any deleted licenses and then save the configuration.

Related information

Import licenses

Change port numbers

Change the default and display language
Combine license files

Configure console users and licensing alerts
Improve performance by specifying thread use
License administration

Monitor licenses and alerts

Reallocate license files

Replace (redownload) license files

Security

System information and logs
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Import license files

Feb 26,2018
After generating your license file from citrix.com, you are ready to import it into the License Server. A startup license is

imported during the License Server installation to allow Citrix products to communicate with the License Server.

e
— O

12.
13.
14.

0 © N ouvhwWwN e

Important

Ensure thatthe license file retains the .lic file name extension. Some copy processes do notrecognize a file type for thatextension
and add a .ixtfile name extension during the copy. The License Server cannotimportlicense files that have the wrong file name

extension.

From a web browser, go to https://Is:8083.

Click Administration and Vendor Daemon Configuration.
Click Import License.

Click the citrix.com link.

On the My Account page, type your user ID and password.
Select All Licensing Tools.

From the main menu, select Allocate.

Follow the process to allocate and generate your file.

. Select the licenses you want to download, click Download, and save the file to a temporary directory.
. Inthe License Administration Console on the Import License File page, browse to the license file.
. If you copied the file directly to the MyFiles directory, orif a file having the same name exists on the License Server,

select Overwrite License File on License Server.

Click Import License.

Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.
Click Reread License Files to allow the license server to recognize the new file.

Users can begin using these licenses when the License Server reads the licenses.
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Change port numbers

Feb 26,2018
Licensing installation sets several port numbers for communications. After installation, you can use the License
Administration Console to change port numbers.

e Console Web Server Port: The HTTPS TCP/IP port that the web server uses to listen for communication with clients
connecting to the License Administration Console. By default, the port is set to 8082. If you are already using that port
number for another application, you can change it to a range between 1 and 65535. If you are upgrading, you maintain
your previous configuration and might not get HTTPS by default. If you change the port, you must stop and restart the
Citrix Licensing service.

e License Server Manager Port: This port number is used by the License Server Manager. License Server Manager handles
the initial communication among the products, starts the vendor daemon, and relays check out and check in requests to
the vendor daemon. By default, this port number is 27000.

Tip: You can verify which port number is being used from the System Information tab in the Administration area.

e Vendor Daemon Port: This port number is used by the Citrix vendor daemon. The vendor daemon is responsible for the
core operations of the License Server, including license allocation. By default, this port number is 7279. However, if you
have a firewall or if the number is already in use, you might need to change the port number.

Tip: You can verify which port number is being used from the Vendor Daemon Configuration tab in the Administration
area.

The License Administration Console replaces the License Server Port Utility for changing port numbers. The License Server
Port Utility was used to change port numbers before this functionality was developed in the License Administration
Console.

Note: The Linux kernel reserves Ports 1 through 1024. When configuring the VPX ports, use ports above 1024. If you use
SSL, use port 8082, which is open in the firewall. If you select a different port for SSL, reconfigure the firewall in the
iptables.

To change the console port

In the top right corner of the console, select Administration.

Click the Server Configuration tab.

Click the Web Server Configuration bar.

Inthe HTTPS Port field, modify the current port number and click Save.

In the host machine operating system, open the Services paneland select the Citrix Licensing service.
Restart the Citrix Licensing service.

o vk wnN g

To change the license server port

This procedure changes the port number used by the License Server Manager (Imadmin.exe).

In the top right corner of the console, select Administration.

Select the Server Configuration tab.

Click the License Server Configuration bar to display the associated options.

Select the Use this Port radio button and type the new port number in the adjacent field. Click Save to save the new
port number.

5. Restart the Citrix Licensing service.

P wnN e
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To change the vendor daemon port

In the top right corner of the console, select Administration.
Select the Vendor Daemon Configuration tab.

Select the Citrix vendor daemon from the table.

Under the Vendor Daemon Port, set the new port number.
Click Save.

Restart the Citrix Licensing service.

o vk wnN g

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.68



Change the default and display language

Feb 26,2018
Change the default language

Administrators can change the default language of the License Administration Console display. The default applies to all
console users. Available languages include:

Chinese (Simplified)

English

French

German

Japanese

Spanish

Users can set a display language for their session. The console display reverts to the default language at the end of each
user session.

1. Click Administration and choose the Server Configuration tab.
2. Click the User Interface bar.
3. Fromthe Default Display Language drop-down list, choose a language.

Change the display language

You can customize your user session by changing the console display language. The console language reverts to the default
when you log off. You can change the display language:

Select the language you want:
e \When prompted during logon.
Or

e By clicking Change Display Language at the bottom left corner of the console
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Combine license files

Feb 26,2018
If you are accumulating a lot of license files on a License Server, you can combine the licenses into one license file. License

files can accumulate when you:

10.
11

12.
13.
14.

© No v bk wN e

Purchase additional licenses
Renew your Customer Success Services membership

Tip

Back up and then delete the old license files from the License Server before replacing them with the new files.

Froma Web browser, go to https://Is:8083.

Click Administration and Vendor Daemon Configuration.

Click Import License.

Click the My Account link.

On the My Account page, enter your user ID and password.

Select All Licensing Tools.

From the main menu, select Redownload.

Use the By Host tab (to automatically combine all specified licenses allocated to a host ID into single line item) and click
Select Allto select allitems on all pages, click the Page check box to select all items on that page, or select the check
boxes preceding the licenses that you want to download.

. Click Download and save the files to a temporary folder (remember the name of the file and location where you

downloaded the file; you will need this location).

In the License Administration Console on the Import License File page, browse to the license file.

If you copied the file directly to the MyFiles directory, or if the file has the same name as an existing one, select
Overwrite License File on License Server.

Click Import License.

Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

Click Reread License Files to allow the license server to recognize the new file.
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Configure console users and licensing alerts

Feb 26,2018
The License Administration Console can use License Administration users, local Windows users and groups, and Active
Directory users and groups. The Citrix Licensing Manager can use local Windows users and groups and Active Directory users
and groups. The License Administration Console manages them all. These users are not connected to the computer local
users.

The Active Directory users and groups are part of an Active Directory/network authentication system. To support them,
ensure that the Windows License Serveris a member of a Microsoft Active Directory domain and running the License
Administration Console. Windows NT domains are not supported.

Users are configured with local roles. All users are created as administrators and can:

e View the Dashboard forlicense activity and alerts.

Change their own password. Active Directory users and groups do not have passwords associated with them. They
contact Active Directory to be authorized and follow standard Active Directory user password policies.
Select a console display language.

Select a console display language.

View system information.

Add and remove users and expire their passwords. You can expire passwords for local users only.
Configure alerts.

Configure the license server.

Configure the vendor daemon.

Stop the license server after you change it.

Configure the administration console.

Configure and add licenses.

Administrators must type user name and password when opening the Administration area. Settings in Server Configuration
allow you to secure the Dashboard by optionally requiring users to log on. If Password Protected Dashboard is enabled, all
users accessing the License Administration Console must log on.

What types of accounts are added at installation

A default administrator account is created during installation of the License Administration Console. Use the administrator
account to first log on to the console and then configure more users.

During installation of the License Administration Console, accounts are added based on machine membership. For
workgroup machine installations, computer\InstallUser and BUILT IN\Administrators are added. For Active Directory
installations, domain\InstallUser and BUILT IN\Administrators are added. You can remove any of these accounts after
installation, but ensure that there is at least one administrator.

Add locally managed users

. Click Administration and then the User Configuration tab.

. Click New Users.

. Select Locally Managed Admin fromthe drop-down menu.

. Type information based on the Role chosen. Required fields are identified with an asterisk (*).
e User names are case-sensitive and cannot contain a backslash (\).

A W N R
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5. Optionally select the User must change password on next logon check box to force the userto create a password.

Add local Windows users and domain users and groups

1. Click Administration and then the User Configuration tab.
1. If you are adding domain users or groups, click Domain Users/groups.
2. Click New Users.
3. Select a role fromthe drop-down menu.
4. Type information based on the Role chosen. Required fields are identified with an asterisk (*).
e Users and groups must be created as domain\user (domain can refer to a machine name) or domain\group.
e |ocal Windows users must be created as computer\user.
e Fordomain users, names are converted to upper case and stored. An upper case domain user name (for example,
TEST\HARVEY) can coexist with a lower case local user name (for example, test\harvey). An upper case domain user
cannot coexist with an upper case local user name.

Change a user password for locally added users

1. Onthe User Configuration page, click Edit in the line containing the user record.

2. Type and confirm the new password.

3. Optionally select the User must change password on next logon check box to force the userto change the new
password.

Configure licensing alerts

Alerts display on the Dashboard and are classified as critical or important. Administrators can select which alerts appear on
the Dashboard and set the thresholds that trigger them.

1. Inthe top right corner of the console, click Administration and select the Alert Configuration tab.

2. Select the alerts you want to display on the Dashboard, and for the important alerts determine the threshold to trigger
the alert.

3. Click Save.

4. By default, Customer Success Services membership alerts are also displayed on the Dashboard. To turn on or off these
alerts:
1. Click Vendor Daemon Configuration.
2. Select the Citrix vendor daemon.
3. Select or clear Enable Customer Success Services membership expiration alerts for this vendor daemon.
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Improve performance by specifying thread use

Feb 26,2018
Requests come in to the license server through a listener port. An acceptance thread must accept all communication. If the
message is accepted, a receive thread handles it and then a processing thread processes it. To improve license server
performance when receiving many requests, you can configure the maximum number of receive and processing threads to
use.

When a programinitiates an 1/0 request (an example would be a request to check out a license), it creates and uses a
thread. The thread maintains the place and data in the program as a reference point. Once the request is complete, the
program can be reentered at the same point. You can have many requests at the same time, depending upon how many
threads are allowed. This technique is called multithreading.

The optimal values needed for acceptable license server performance dependent on the hardware, the site configuration,
and the request volume. If you set the limits too high and your hardware cannot support it, it slows down the
communication. If you set the limits too low, it takes longer for the communication to occur. The systemwaits until it can
create more threads before it executes incoming requests. Test and evaluate different values to determine the
configuration that meets your site needs. A good starting point for a large-scale deployment might be setting:

e Maximum Number of License Server Manager Processing Threads to 30.

e Maximum Number of License Server Manager Receiving Threads to 15.

There are two areas where you can specify the thread limits:
e License Server
e Web server

Set license server thread use

1. Inthe top right comner of the console, click Administration.

2. Click the Server Configuration tab and the License Server Configuration bar.

3. Modify the Maximum Number of License Server Manager Processing Threads and Maximum Number of License
Server Manager Receiving Threads fields (up to 999 threads).

4. Restart the Citrix Licensing service.

Set web server thread use

Use this procedure to set the maximum number of threads that the web server for the License Administration Console uses
to process requests. Specify a larger number if you expect many users to access the console simultaneously.

1. Inthe top right corner of the console, click Administration.

2. Click the Server Configuration tab and the Web Server Configuration bar.

3. Modify the Maximum Number of Web Server Threads field (up to 999 threads).

4. Restart the Citrix Licensing service.
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License administration

Feb 26,2018
Afteryou have imported your license files, the Citrix vendor daemon (CITRIX) administers them. The Citrix vendor daemon is
responsible for core operations of the License Server, such as tracking how many licenses are checked out and who has
them. The vendor daemon can manage all your Citrix license files and is fully backward compatible with any license files you
have. Set properties for the vendor daemon on the Vendor Daemon Configuration screen of the console.

Important

You can manage only the Citrix vendor daemon by using this console. We don'tsupport running the Citrix vendor daemon on non-

Citrix license servers.

Configuring the vendor daemon

The Vendor Daemon Configuration screen allows you to import license files, configure the vendor daemon, and view logs
about license activity. Only users that have administrator privileges can view this screen.

Click Administer in the vendor daemon summary grid to set these options:

Option Description

Vendor The TCP/IP port number that the vendor daemon uses for communication with products.
Daemon Port

in Use

Stop Stops the vendor daemon, but leaves the console running. When you stop a vendor daemon, this

button changes to Start. Disabled by default.

Start Starts the vendor daemon and reads the license files. This button only appears when the vendor
daemon is stopped. When you start a vendor daemon, this button changes to Stop.

Reread Rereads the contents of the license files and the options file.
License Files

Report Log This option is not functional.

Name

Rotate This option is not functional.

Report Logs
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Monitor licenses and alerts

Feb 26,2018

Use the Dashboard to monitor your license activity. The Dashboard is the default view when you open the License

Administration Console.

License status at a glance

The Dashboard presents a synopsis of your licenses:

Name Description

Product Product, edition, and type of license

CSS Date The Customer Success Services membership expiration date for the product license

In Use The number of licenses currently in use, followed by the total number available for use

(Available)

Expiration The date the license expires

License Type The type of license, such as concurrent user or system licenses

Hosts The Hosts link appears when licenses are checked out and links to a list of the host names with
licenses in use

About alerts

Licensing events such as the license server stopping or the expiration of a Citrix Customer Success Services membership
trigger dashboard alerts. You configure alerts in the Administration area. The list of displayed alerts is updated when the

Dashboard page is reloaded or refreshed.

Alerts about concurrent licenses are tested and triggered at one-minute intervals. The "Vendor Daemon Down" alert is

triggered immediately.
There are two categories of alerts:

Q Critical alerts

Dashboard Alert Administration
Name

The vendordaemon | Vendor daemon

has stopped down

The concurrent Out of

license has expired concurrent
licenses

Triggering Event

The license server stops, unexpectedly or purposely stopped by the
administrator.

All the concurrent licenses have been checked out.
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Hi)%safr Alert ggrr}lcilrjlri';.etr}gt ion h%acé?lnnse Eas e%(pwed If the license is not a type of license covered
product_name have ngrrﬁsee expired ustomer Success Services there is no deleterious effect from being
expired expired. For example, the startup license and evaluation licenses are always

"expired" because they are not covered by Customer Success Services. You
canignore this alert unless it is for a license that shows an expired Customer
Success Services date in the dashboard.
Customer Success Customer The Customer Success Services membership for a concurrent license has
Services membership | Success expired.
expired Services
membership
expired

/) Important alerts

Name of Triggering Event

Alert

Concurrent | A percentage (specified by the administrator) of concurrent licenses have been checked out.

threshold

exceeded

Concurrent | Some days (specified by the administrator) remain before the concurrent license expires.

license

expiring

Customer Some days (specified by the administrator) remain before the Customer Success Services membership for
Success a license expires. If the license is not a type of license covered by Customer Success Services, there is no
Services deleterious effect from being expired. For example, the startup license and evaluation licenses are always
membership | "expired" because they are not covered by Customer Success Services. You can ignore this alert unless it
expiring is for a license that shows an expired Customer Success Services date in the dashboard.

To view alerts

1. Onthe Dashboard, click the red X icon to view critical alerts or the orange ! icon to view important alerts.
2. Click items in the list to their details.

To clear alerts

Alerts are not cleared automatically when the condition changes. Clear the alert manually to remove it fromthe list.

Click the X icon next to the alert item.
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Reallocate license files

Feb 26,2018
License files run only on the license server or hardware appliance that was specified when they were generated. If you

change the binding identifier of a server or appliance hosting license files, reallocate license files so that they match the new
binding identifier.

The binding identifier is the information in the license file that identifies the machine where the license file is hosted. The
binding identifier is usually the license server hostname, but it can also be a hardware appliance name, Ethernet address
(MAC address), or FQDN.

Situations in which you might need to reallocate a license file:

e You rename your license server

e You want to move your license files to a server that has a different name

e You used some licenses initially to create a test environment and now you want to reuse those licenses on a different
license server

Designating a new binding identifier when you reallocate licenses does not consume more licenses. The process changes
only the binding identifier for the licenses.

Reallocate license files by using the License Administration Console

Froma web browser, go to https://Is:8083.

Select Administration and Vendor Daemon Configuration.

Select Import License.

Select the My Account link.

On the My Account page, type your user ID and password.

Select All Licensing Tools.

From the main menu, select Reallocate.

Select the check boxes preceding the licenses you want to reallocate, click Continue.

Follow the instructions to select the licenses to reallocate in to the new file (and associated with a new license server)

and downl